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1.  ВСТУПЛЕНИЕ 
 
Поздравляем Вас с покупкой нового бегового компьютера Polar RS800/800sd! 
Ваш беговой компьютер поможет Вам достичь целей вашей тренировки. Он обеспечивает обратную связь с Вашим 
телом, чтобы обеспечить эффективные тренировки. 

          
2.  ДЕТАЛИ БЕГОВОГО КОМПЬЮТЕРА 
 

 
1. Беговой компьютер Polar RS400/RS800. Показывает на дисплее и записывает ваш сердечный ритм и другие 

данные во время выполнения упражнения. 
2. Передатчик Polar WearLink® 31 (Polar RS400) или Polar WearLink® W.I.N.D. (Polar RS800). Передатчик посылает 

сигнал сердечного ритма на беговой компьютер. Передатчик состоит из разъема и ремешка. 
3. Датчик бега Polar S1 foot pod™ (Polar RS400). Датчик передает данные о скорости/темпе бега и дистанции на 

ваш беговой компьютер. 
4. Датчик бега Polar s3 stride sensor™ W.I.N.D. (Polar RS800). Датчик передает данные о скорости/темпе бега и 

дистанции на ваш беговой компьютер. Датчик также измеряет ритм бега и длину шага. 
5. CD-ROM. CD включает Polar ProTrainer5™ и полный комплект инструкций для пользователя. 
 
3.  ПОДГОТОВКА 



Фирменный магазин PolarSport.ru

Polar RS800 Руководство пользователя                   5 
 
 
 
Основные настройки 

 
 
Прежде чем начать упражнение с вашим беговым компьютером, установите основные настройки на требуемую 
величину. Введите как можно более точные данные, чтобы обеспечить правильную обратную связь, основанную на 
ваших метрических данных.  
 
Для изменения настроек используйте кнопки UP, DOWN и OK. Изменение настроек будет идти быстрее, если 
нажать и удерживать в этом положении кнопки UP и DOWN. 
 
1. Для активирования вашего бегового компьютера нажмите два раза кнопку ОК. 
2. На дисплее появится Welcome to Polar Running World (добро пожаловать в мир бега Polar).  

Нажмите кнопку ОК. 
3. Язык. Выберите English, Deutch, Espanol, Francaise. 
4. На дисплее появится Start with basic settings (начните с основных настроек). Нажмите ОК.   
5. Время. Выберите 12h (12-часовой) или 24h (24-часовой) режим. При 12h выберите АМ (до полудня) или РМ 

(после полудня). Установите местное время. 
6. Дата. Установите сегодняшнюю дату: dd = день, mm = месяц, уу = год.  
7. Единицы измерения. Выберите метрическую (кг/см/км) или английскую (фунты/футы/мили) систему.  
8. Вес. Введите ваш вес. Для изменения единиц измерения нажмите и удерживайте кнопку LIGHT. 
9. Рост. Введите ваш рост. При использовании английской системы сначала введите футы, затем дюймы. 
10. Дата рождения. Введите ее, используя схему dd = день, mm = месяц, уу = год. 
11. Пол. Выберите Male (муж.) или Female (жен.)   
12. На дисплее появится Settings OK? (настройки ОК?). Выберите Yes (да) – настройки будут приняты и 

сохранены. На дисплее бегового компьютера появится текущее время. Если настройки неверны и нуждаются в 
корректировке, выберите No (нет). Нажимая STOP, перейдите к параметру, который требуется изменить. 
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Структура меню  

 
 
4.  ПОДГОТОВКА К ТРЕНИРОВКЕ 
 
Надевание передатчика 
 
Для измерения сердечного ритма наденьте передатчик. 
 
1. Смочите места расположения электродов на внутренней стороне ремешка под струей воды и убедитесь, что 

они достаточно увлажнены. 
2. Пристегните разъем к ремешку. При этом буква L на разъеме должна располагаться на слове LEFT (левый) 

на ремешке. Теперь защелкните замок. Длину ремешка установите так, чтобы было удобно и комфортно. 
Расположите ремешок вокруг груди так, чтобы он проходил прямо под грудными мышцами, и защелкните 
второй замок.  

3. Убедитесь, что увлажненные места, где расположены электроды, плотно прилегают к коже, а логотип Polar на 
разъеме находится в центре и в вертикальном положении.  

4. Для того чтобы отстегнуть разъем от ремешка, надавите большим и указательным пальцами и поверните 
руку так, как это показано на картинке. 

 
 Передатчик Polar WearLink может применяться со специальным чехлом, в котором имеются электроды, 
вшитые в мягкую ткань. Смочите место расположения электродов. Прикрепите разъем передатчика 
непосредственно к чехлу без ремешка так, чтобы  логотип Polar находился в вертикальном положении.  
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Размещение датчика бега Polar s3 Stride Sensor W.I.N.D.  
 
Установка батарейки датчика бега 
 
Прежде чем использовать датчик* в первый раз, установите батарейку (входит в комплект изделия). 
 

 
1. Откройте крышку батарейного отсека, повернув ее против часовой стрелки с помощью вилки датчика или 

монеты в сторону надписи OPEN (см. рис. 1). 
2. Установите батарейку так, чтобы положительно заряженная ее часть (+) смотрела на крышку (см. рис. 2). 
3. Установите крышку не место.  
4. Надавив на крышку, поставьте ее на место и закройте, поворачивая по часовой стрелке от надписи OPEN к 

надписи CLOSE с помощью вилки датчика или монеты.  
 
Датчик бега можно устанавливать либо на шнурках обуви, либо в специальном углублении в обуви. 
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Установка датчика бега на обуви 

 
1. Раскройте створки и отделите вилку. 
2. Ослабьте шнурки и поместите вилку под ними, поверх язычка обуви. Завяжите шнурки. 
3. Приладьте переднюю часть датчика  к вилке и надавите с противоположного конца. Защелкните замок.  
4. Убедитесь, что при этом датчик не сдвинулся и стоит ровно относительно обуви. Чем прочнее будет 

установлен датчик, тем более точные показатели скорости и дистанции он выдаст. 
 
Установка датчика шага в специальное углубление под стелькой 

 
1. Раскройте створки и отделите вилку. 
2. Выньте стельку и установите датчик в углубление так, чтобы логотип Polar смотрел вверх, а задний конец 

датчика был направлен в сторону задника обуви. Имейте в виду, что это – единственный вариант установки 
датчика. Старайтесь при установке не применять слишком большое усилие.  

 
 Опциональная калибровка датчика может улучшить точность измерения скорости, темпа и дистанции. 
Более подробно см. в разделе «Калибровка датчика шага». 

 
* Здесь требуется опциональный датчик s3 Stride Sensor W.I.N.D. 
 
Калибровка датчика бега 
Опциональная калибровка датчика улучшает точность измерения скорости, темпа и дистанции*. Прежде чем 
использовать датчик в первый раз, рекомендуется провести его калибровку, а также в случае существенного 
изменения стиля  вашего бега или положения датчика в обуви (например, в случае использования новой пары 
обуви). Калибровку датчика можно провести, пробежав известную дистанцию или путем установки 
калибровочного коэффициента вручную.  
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Калибровка датчика бега путем бега на дистанцию (динамическая калибровка) 
 
Вы можете провести калибровку датчика на любой стадии ваших упражнений с коррекцией длины круга при 
условии, что вы не выполняете целевое дистанционное упражнение. Просто пробегите известную дистанцию 
(желательно длиннее 1000 метров). 
 
Убедитесь, что при этом Датчик находится во включенном состоянии. 
 
Выберите Select > Features > S sensor (выбор > параметры > датчик шага). 
 
В режиме времени дважды нажмите кнопку ОК, после чего начинайте бег.  
 
Вы можете провести калибровку датчика во время любого круга бегового упражнения. Находясь на стартовой 
точке круга известной длины, нажмите на ОК и начинайте бег. Пробежав всю длину круга, произведите 
калибровку, выбрав один из двух указанных ниже способов: 
 
1. Прекратите бег, замрите на месте, нажмите и удерживайте кнопку LIGHT, чтобы перейти к Settings.  
2. Прекратите бег, замрите на месте, нажмите один раз на кнопку STOP. Выберите Settings.  
 
Выберите Calibrate>Correct lap>Set true distance (калибровать>правильная длина круга>установить 
правильную длину дистанции). Зафиксируйте показанную на дисплее длину круга с дистанцией, которую вы 
только что пробежали, и нажмите ОК. 
 
Calibration complete (калибровка завершена) и на дисплее появляется коэффициент. Теперь Датчик 
откалиброван и готов к работе. 
 
Установка калибровочного коэффициента вручную 
 
Калибровочный коэффициент рассчитывается как соотношение между фактической дистанцией и 
некалиброванной дистанцией. Например: вы пробежали 1 200 м. Беговой компьютер показывает 1 180 м; 
калибровочный коэффициент составляет 1,000. Расчет калибровочного коэффициента: 1,000 х 1200/1180 = 
1,017. Диапазон измерений для калибровочного коэффициента составляет 0,500-1,500. 
 
Существует 4 варианта  установки калибровочного коэффициента: 
 
1. До начала упражнения. 
 
Выберите Settings>Features> S sensor >Calibrate (настройки>параметры>датчик>калибровать). 
 
Установите Calibration factor (калибровочный коэффициент) и нажмите ОК. Датчик теперь откалиброван. 
 
2. После начала измерения ритма сердца и до начала записи упражнения. 
 
В режиме времени выберите Settings> S sensor >Calibrate. 
 
Установите Calibration factor и нажмите ОК. Датчик теперь откалиброван, можно начинать запись  
упражнения нажатием на ОК. 
 
3. Во время выполнения упражнения путем прерывания его записи.  
 
Начните упражнение двукратным нажатием ОК в режиме времени. Нажмите один раз на кнопку STOP, что 
прервет запись упражнения. 
 
Выберите Settings>Calibrate>Set factor (настройки>калибровать>установить калибровочный коэффициент). 
Установите Calibration factor и нажмите ОК. Датчик теперь откалиброван. Продолжите упражнение нажатием 
ОК. 
 
4. Во время выполнения упражнения без прерывания его записи.  
 
Начните упражнение двукратным нажатием ОК в режиме времени. Нажмите и удерживайте кнопку LIGHT, 
чтобы перейти к Settings.  
 
Выберите Calibrate>Set factor. Установите Calibration factor и нажмите ОК. Датчик теперь откалиброван. 
Продолжите бег. 
 

 Если на дисплее появляется фраза S sensor calibration failed, она означает, что калибровка датчика не 
удалась и ее следует повторить. 
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* Здесь требуется опциональный датчик s3 Stride Sensor W.I.N.D. 
 
Планирование процесса вашей тренировки 
 
Типы упражнений 
Ваш беговой компьютер позволяет использовать как уже имеющиеся упражнения, так и создавать новые. Вы 
можете создать разнообразные упражнения и перенести их на ваш беговой компьютер, используя Polar 
ProTrainer5. 
Выберите Settings>Exercise (настройки>упражнение). 

 
Меню упражнений показывает весь их перечень. Продвигайтесь по типам упражнений, используя кнопки UP и 
DOWN, а, выбрав нужный тип, нажмите ОК. 

 
• Free: свободное упражнение без заданных параметров.  
• Basic: базовые упражнения со средней интенсивностью. Продолжительность – ок. 45 мин. 
• Interval: базовая тренировка интервалами. Упражнение начинается с 15-минутной разминки. После нее 

следует 1-км интервал с 3-минутной передышкой, который повторяется 5 раз. Данная комбинация 
заканчивается 15-минутной заминкой. 

• OwnZone: базовое, основанное на OwnZone (собственная зона) упражнение со средней интенсивностью. 
Предлагаемая продолжительность – ок. 45 мин. Беговой компьютер может автоматически установить ваш 
индивидуальный аэробный (сердечно-сосудистый) сердечный ритм. Это и называется OwnZone. Более 
подробно см. в разделе «Определение вашей OwnZone». Дополнительная информация имеется в 
разделе «Тренировка по OwnZone». 

• Add new: создайте и поместите в память ваши собственные базовые упражнения. В память бегового 
компьютера можно поместить всего 10 упражнений + 1 свободное упражнение без заданных параметров. 

 
После выбора упражнения на дисплее появляются следующие варианты. Выберите требуемый и нажмите 
ОК. 
 
• Выберите: упражнение по умолчанию. Во время следующей тренировки беговой компьютер предложит 

вам это упражнение по умолчанию. 
• Просмотрите: настройки упражнений. Используйте кнопки UP и DOWN для просмотра: 
 
1. Базового упражнения с 1-3 зонами упражнений: наметьте границы сердечного ритма или скорости/темпа* 

для каждой зоны, время/расстояние* для зоны, или 
2. Упражнение, созданное с программным обеспечением: название, описание, намеченное время 

упражнения. (Нажмите и удерживайте кнопку LIGHT, чтобы просмотреть фазы упражнения и выбранный 
спортивный профиль). 

 
• Edit Basic или OwnZone: отредактируйте базовое упражнение или OwnZone, чтобы сделать их 

соответствующими вашим потребностям. Редактировать упражнение можно также с помощью вашего 
бегового компьютера. Подробнее см. в «Создание новых упражнений». Если у вас есть вновь созданные 
с программным обеспечением упражнения, которые включают циклы, их редактирование с помощью 
бегового компьютера невозможно.   

• Rename Basic, Interval: изменить название базовых, интервальных или иных упражнений, созданных с 
помощью бегового компьютера. 

• Default: вернитесь к настройкам по умолчанию упражнений Basic, Interval или OwnZone. 
• Delete: удаление упражнений, созданных с помощью бегового компьютера или программного 

обеспечения. 
 
Создание новых упражнений 
 

Создание новых упражнений с зонами 
Создайте ваши собственные упражнения с помощью бегового компьютера. С помощью Polar ProTrainer5 
можно создавать еще более разнообразные упражнения. Более подробно см. в разделе о помощи с 
программным обеспечением. 
 
Выберите Settings>Exercises>Add new (настройки>упражнения>добавить новое). 
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1. Установите Number of zones (число зон) для упражнений (0-3) и нажмите ОК. Для 0-вых зон см. раздел о 

создании новых упражнений без зон. 
2. Выберите Zone type (тип зон). 
 
А. Зоны сердечного ритма 
 
Б. Зоны скорости/темпа*. 
 
Нажмите ОК. Продолжайте по своему выбору. 
 
A. Для зон сердечного ритма, выберете спортивные зоны, или вручную зоны сердечного ритма. Нажмите OK. 
 
• Sport zone (спортивная зона): выберите для упражнения одну из спортивных зон (например, Z1 – 50-

59%). Нажмите ОК. 
 
Спортивные зоны Polar – это участки интенсивности сердечного ритма, выраженные в процентах от вашего 
максимального сердечного ритма. На беговом компьютере по умолчанию установлено 5 различных 
спортивных зон: очень легкая (50-59% сердечного ритма), легкая (60-69% сердечного ритма), средняя (70-
79% сердечного ритма), трудная (80-89% сердечного ритма), максимальная (90-99% сердечного ритма). 
Сердечный ритм по умолчанию обычно устанавливается на основании возраста, однако если вы знаете свои 
аэробные или анаэробные пороги, зафиксируйте свой прогнозируемый максимальный сердечный ритм (HRmax 
– p), измеренный в ходе теста Polar Fitness Test™, ваш максимальный сердечный ритм, измеренный 
самостоятельно или в лаборатории, и тогда вы сможете выбрать такие спортивные зоны, которые в 
наибольшей степени соответствуют вашим потребностям.  
 
• Manual (вручную): установите лимиты высшей и низшей зоны в виде числа ударов в минуту или % 

сердечного ритма / %  резерв сердечного ритма и нажмите ОК.  
 
Продолжение - шаг 3. 
 
Б. Если вы выбрали зоны скорости/темпа*, установите их верхний и нижний лимиты и нажмите ОК. 
 
Продолжение - шаг 3. 
 
3. Установите Zone guide (проводник по зонам) на изменение зоны после определенного времени или 

дистанции*. Во время выполнения упражнения беговой компьютер подаст вам звуковой сигнал в момент 
изменения зоны.  
 

• Timers: установите таймер на зону (минуты и секунды) и нажмите ОК. Или 
• Distances*: установите дистанцию на зону и нажмите ОК. Или 
• Off: установите таймеры и дистанции на Off (Выкл) и нажмите ОК. 
 
После того как вы определились с первой зоной, на экране появится Zone 1 OK (зона 1 ОК). Для упражнений, 
проводимых в пределах более одной зоны, повторите вышеуказанный порядок действий для ввода 
параметров последующих зон. 
После того как подготовка упражнения закончена, на экране появится New exercise added (добавлено новое 
упражнение). Новое упражнение (NewExe) сохраняется в меню Exercise, откуда можно его выбрать на 
следующей тренировке. Дайте упражнению новое название, выбрав в списке Rename (переименовать).    
 
Создание новых упражнений без зон 
 
Если вы создаете новое упражнение без зон, таймер и длину дистанции* можно использовать для 
регулирования тренировки.  
 
Выберите Settings>Exercises>Add new.  
 
1. Number of zones: установите число зон на 0. 
2. Guide type: выберите подачу звукового сигнала таймера во время тренировки (например, чтобы 

напомнить вам выпить воды) или установите дистанцию* (число последующих кругов, не вводя их в 
память). 

 
Таймеры 
• Number of timers: выберите число срабатываний таймера (1-3) для тренировки. Нажмите ОК.  
• Timer 1: введите число минут и секунд для таймера и нажмите ОК. 
Дистанции* 
 
• Number of distances: выберите число дистанций (1-3) для тренировки. Нажмите ОК.  
• Distance 1: введите дистанцию (дистанции) и нажмите ОК. 
 

Повторяйте действие 2, пока требуемые таймеры и дистанции* не будут введены. Когда упражнение готово, 
на экране появится New exercise ready (новое упражнение готово). Новое упражнение (NewExe) сохраняется 
в меню Exercise, откуда можно его выбрать на следующей тренировке. Дайте упражнению новое название, 
выбрав в списке Rename (переименовать).    
 

* Здесь требуется опциональный датчик s3 Stride Sensor W.I.N.D. 
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5.  ТРЕНИРОВКА 
 
Начало упражнения 
 
Наденьте передатчик и датчик шага, как это указано выше. Убедитесь, что вы активировали Датчик в вашем 
беговом компьютере (Settings>Features>S sensor). 
 

 
 
1. Нажатием на ОК начните измерять сердечный ритм. 
2. В течение 15 секунд сердечный ритм отобразится на дисплее. Стойте спокойно и ожидайте, пока беговой 

компьютер обнаружит сигнал Датчика (фигурка бегуна перестанет мигать). Для ускоренной смены вида 
упражнения нажмите и держите кнопку UP. Для ускоренной смены вида упражнения нажмите и держите 
кнопку DOWN. 

3. Нажатием на ОК начинайте упражнение. 
 
В качестве альтернативы для просмотра вариантов настроек до начала упражнения  можно выбрать Settings 
– подробнее см. раздел Settings на стр. 7. 
 
Меню Settings показывает следующие варианты: 
 
• Exercise: выберите тип упражнения или просмотрите настройки упражнений. 
 
Exercise: выберите Free, Basic, Interval или OwnZone. (Если вы создали новые упражнения, они также будут 
отображены на дисплее).  
 
Select: установите упражнения по умолчанию, чтобы оно было выполнено сразу же, или 
 
View: просмотрите настройки упражнений. 
 
• Rec. time: установите скорость записи. 
• TZ Alarm: переключите сигнал целевой зоны на Вкл или Выкл. 
• HR view: выберите показ сердечного ритма в ударах в минуту или в процентах от максимального 

сердечного ритма. 
• HeartTouch: задайте функцию HeartTouch™. 
• Shoes: выберите обувь, чтобы отслеживать ее использование. 
• Speed view: выберите вариант показа скорости*: км/час, миль/час, мин/км, мин/миль. 
• S sensor: выберите режим Вкл/Выкл Датчика. 
• A.Lap: выберите режим Вкл/Выкл для автоматической функции круга. 
• Display: измените картинку дисплея (подробнее см. в разделе о персонификации дисплея бегового 

компьютера во время тренировки). 
 

 Если на дисплее появляется надпись (название упражнения) requires S sensor. Turn S sensor on 
(упражнение …нуждается в датчике бега. Включите датчик бега), выполняемое вами упражнение 
нуждается в том, чтобы на дисплее отображались данные скорости/темпа и дистанции* (например, вы 
определили для упражнения зоны скорости/темпа*). Выберите Yes для того, чтобы включить датчик, и 
убедитесь, что вы установили его согласно инструкции. Если на дисплее появляется надпись Exercise 
displays updated (показ на дисплее упражнения обновлен), во время упражнения на дисплее будут 
показаны скорость/темп и дистанция*.        

 
* Здесь требуется опциональный датчик s3 Stride Sensor W.I.N.D. 
 
Информация на дисплее 
 
Во время тренировки информация, появляющаяся на дисплее, зависит от ваших настроек. Нажимая UP и 
DOWN, пройдитесь по настройкам. Вариант картинки дисплея, выбранный из нижнего ряда, появляется в 
течение нескольких секунд. 
 
В режиме по умолчанию дисплей показывает: 
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Вид Heart rate (сердечного ритма) 
 
Скорость*/Темп*/Калории 
 
Секундомер 
 
Сердечный ритм 
 
Вид Stopwatch (Секундомер) 
 
Калории 
 
Скорость/Темп/Время 
 
Секундомер 
 
Вид Lap time (время круга) 
 
Указатель зоны 
 
Сердечный ритм 
 
Время круга 
 
Вид Speed/pace (скорость/темп) 
 
Ритм* 
 
Дистанция* 
 
Скорость/темп* 
 
Вид Distance* (дистанция) 
 
Таймер обратного отсчета 
 
Указатель зоны 
 
Дистанция*/Время круга 
 
Вид Altitude (высота над уровнем моря) 
 
Сердечный ритм 
 
Крутизна 
 
Высота 
 
Упражнения, созданные с помощью Polar ProTrainer5 
Если вы загрузили программу из программного обеспечения, детали вашего упражнения 
можно видеть на отдельном дисплее. Подробнее см. в разделе об упражнениях по 
созданным программам. Изменять картинку дисплея с помощью бегового компьютера 
нельзя. 

 
Подробнее о персонификации любой картинки дисплея см. в разделе о персонификации дисплея во время 
тренировки. 
 
* Здесь требуется опциональный датчик s3 Stride Sensor W.I.N.D. 

 
Символы на дисплее 
 
Текст на дисплее   Символ   Значение 
 

Time of day        Текущее время 
 

Countd. time or Countd. distance     Таймер обратного отсчета  
         времени или дистанции 
 
Lap time        Номер и время круга 
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Текст на дисплее   Символ   Значение 
 

Lap distance*        Номер и длина круга 
 
Stopwatch        Общая продолжительность  
         упражнения на данный момент 
 
Heart rate        Текущий сердечный ритм 
 
Calories        Израсходованное количество  
         калорий 
 
Distance*        Расстояние, покрытое на данный 
         момент 
 
Speed/pace*        Текущая скорость/темп 
 
Zone pointer (сердечного ритма)    Индикатор целевой зоны с  
         символом сердца, вправо или  
         перемещающимся влево в  
         пределах зоны. Если символ не  
         виден и/или звучит звуковой  
         сигнал, ваш сердечный ритм  
         вышел за пределы целевой зоны.   
 
Zone pointer (скорость/темп)    Индикатор целевой зоны с  
         символом, перемещающимся  
         вправо или влево в пределах  
         зоны. Если символ не виден и/или 
         звучит звуковой сигнал, ваш  
         сердечный ритм вышел за  
         пределы целевой зоны.   
 
Zone pointer (спорт. зона Polar)     Индикатор целевой зоны с  
         символом сердца,   
         перемещающимся вправо или  
         влево в пределах спортивной зоны 
         согласно вашему сердечному  
         ритму. Подробнее см. в разделе о 
         функциях кнопок во время  
         упражнения. 
 

Target zone       График, показывающий ваш  
         фактический сердечный ритм в  
         сравнении с заданными зонами  
         сердечного ритма.  
 
RR variation        Варьирование временного  
         интервала между ударами сердца  
 
Ascent         Крутизна в м/футах 
 
Altitude         Текущая высота над уровнем моря 
 
Cadence*        Ритм бега (пара шагов/мин) 
 
* Здесь требуется опциональный датчик s3 Stride Sensor W.I.N.D. 
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Функции кнопок во время упражнения 
 
Выбор круга 
 

 

 
 
 

 

 
Нажмите ОК для записи круга. На дисплее появятся: 
 
Номер круга 
 
Средний сердечный ритм на круге 
 
Время круга 
 
Если датчик шага* активирован, на дисплее также появится: 
 
Номер круга 
 
Длина круга 
 
Средняя скорость/темп на круге 
 

Блокирование зоны 
 
При выполнении упражнения без заданных целевых зон вы можете произвести «привязку» вашего 
сердечного ритма к спортивной зоне. Таким образом, если у вас не было достаточно времени для установки 
заданных целевых зон до упражнения, это можно сделать по ходу сеанса тренировки. 
 
Для блокировки/разблокировки зоны нажмите и удерживайте кнопку ОК. 
 
Во время запрограммированного упражнения нажмите и удерживайте кнопку ОК и из Lap menu выберите 
Lock zone/Unlock zone (заблокировать/разблокировать зону). 
 
Если, например, вы бежите с сердечным ритмом 130 уд./мин, что составляет 75% вашего максимального 
сердечного ритма и соответствует спортзоне 3, вы можете нажать и удерживать кнопку ОК для того, чтобы 
заблокировать ваш сердечный ритм в рамках данной зоны. На экране появится Sport zone3 Locked 70-79% 
(заблокирована спортзона 3) .  Если вы окажетесь вне зоны, раздастся звуковой сигнал (в случае, если 
функция сигнала включена). Разблокируйте спортзону, вновь нажав и удерживая ОК. На экране появится 
Sport zone3 Unlocked  (спортзона 3 разблокирована).  
 
Используя программное обеспечение, вы также можете базировать  ZoneLock (зонный замок) на вашей 
скорости*/темпе. Подробнее см. в разделе о программном обеспечении. 
 
Изменение масштаба изображения дисплея 

 
Для изменения масштаба верхнего ряда нажмите UP, нижнего ряда – DOWN. Возврат к нормальному 
масштабу дисплея - через нажатие и удерживание этих же кнопок. 
 
Включение подсветки дисплея (режим Night (ночь) Вкл)  
 
Для освещения дисплея во время упражнения нажмите LIGHT. Включится ночной режим, и подсветка будет 
работать до тех пор, пока не нажата любая кнопка или не закончился цикл упражнения. 
 
Вид меню настроек 
 
Нажмите и удерживайте кнопку LIGHT > Settings. 
 
Меню  Settings отображается на дисплее при нажатии и удерживании кнопки LIGHT. В этом меню вы 
можете поменять некоторые настройки, не прерывая записи упражнения. Содержание этого меню 
различается в зависимости от типа упражнения. Подробнее см. на стр. 7 – Settings. 
 Prev. phase – вид краткой информации о предыдущем цикле или повторении (показывается на дисплее, 

когда в программном обеспечении создано упражнение с циклами). 
 Keylock – блокировка (разблокировка) кнопок от случайного нажатия. 
 TZ Alarm – Вкл/Выкл звукового сигнала целевой зоны. 
 Change zone – переключение целевых зон (показывается на дисплее, когда вы намечаете несколько 

целевых зон, кроме случая, когда упражнение с циклами создается в программном обеспечении). 
 HR view – выбор варианта показа на дисплее вашего сердечного ритма. 
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• Calibrate: команда на калибровку датчика бега* (не дисплее отсутствует, если датчик шага* выключен) 
• Seek sensor: ведет поиск данных WearLink и датчика бега*, если сигнал пропадает под воздействием 

помех. 
• A.Lap*: активирует/деактивирует автоматический круг. 
 
После того как вы изменили настройки, беговой компьютер вернется в режим упражнения. 
 
Пауза в упражнении  
 
Во время режима паузы вы можете: 
 
• Continue: продолжить запись упражнения 
• Exit: остановить запись упражнения (или нажмите STOP) 
• Summary: видеть краткую информацию об упражнении на данный момент времени. На дисплей 

выводится следующая информация: калории, дистанция*, время упражнения, максимальный сердечный 
ритм, минимальный сердечный ритм , средний сердечный ритм, максимальная скорость/темп* и средняя 
скорость/темп*   

• Settings: во время паузы вы можете изменить те же настройки, что и в режиме упражнения, кроме 
персонификации информации на дисплее, которую можно произвести только в режиме паузы с помощью 
бегового компьютера 

• Reset: удалить записанную информацию об упражнении. Подтвердите это нажатием на ОК и еще раз 
нажмите на ОК, чтобы возобновить запись    

• Free mode: изменить профиль вашего упражнения на свободный. Это не приводит к удалению 
выполненного вами упражнения, но будет продолжать упражнение без настроек. Если вы переключитесь 
на Free mode, вы можете вновь начать оригинальное упражнение, сделав еще одну паузу в упражнении и 
выбрав Restart P1. 

 
* Здесь требуется опциональный датчик s3 Stride Sensor W.I.N.D. 
 

Определение вашей собственной зоны 
 
Вводную информацию о Polar OwnZone® см. в разделе о тренировке по OwnZone. 
 
Найдите вашу OwnZone в течение первых 5 минут, пока идет разминка и бег трусцой. Упражнение следует 
начинать осторожно, с малой нагрузкой, постепенно увеличивая ее, чтобы вырос сердечный ритм. 
 
Повторное определение вашей OwnZone: 
 
• При изменении среды, в которой проходит тренировка, или изменении режима упражнения. 
• При возобновлении упражнений после более чем недельного перерыва. 
• В ситуации, когда вы не на 100% уверены в своем физическом или моральном состоянии, например, если 

вы еще не совсем «отошли» от предыдущего упражнения, чувствуете себя неважно или испытываете 
стресс. 

• После изменения настроек пользователя. 
 Прежде чем приступать к определению вашей OwnZone, убедитесь, что: 
• Ваши настройки пользователя правильны. 
 
Вы выбрали именно упражнение OwnZone. Всякий раз, когда вы начинаете упражнение OwnZone, беговой 
компьютер автоматически определяет вашу OwnZone. 
 
1. Наденьте передатчик и датчик бега*, как это указано выше. Начните измерения двукратным нажатием на 

ОК. 
2. Когда упражнение начато, на экране появляется OZ, и начинается определение OwnZone. 
 
Определение вашей OwnZone происходит за пять стадий. После каждой стадии цикла вы будете слышать 
звуковой сигнал (если он включен), означающий ее завершение. 
 
OZ> Двигайтесь медленным шагом в течение 1 мин. На первой стадии удерживайте ваш сердечный ритм 
ниже 100 уд./мин/59% макс. сердечного ритма.   
 
OZ>> Двигайтесь нормальным шагом в течение 1 мин. Медленно увеличивайте ваш сердечный ритм на 10-20 
уд./мин/5% макс. сердечного ритма. 
 
OZ>>> Двигайтесь быстрым шагом в течение 1 мин. Увеличивайте ваш сердечный ритм на 10-20 уд./мин/5% 
макс. сердечного ритма. 
 
OZ>>>> Бегите трусцой в течение 1 мин. Увеличивайте ваш сердечный ритм на 10-20 уд./мин/5% макс. 
сердечного ритма. 
 
OZ>>>>> Бегите быстрой трусцой в течение 1 мин. Увеличивайте ваш сердечный ритм на 10 уд./мин/5% макс. 
сердечного ритма. 
 
3. В определенной точке этой фазы вы услышите два последовательных звуковых сигнала. Это означает, 

что ваша OwnZone определена. 



Фирменный магазин PolarSport.ru

Polar RS800 Руководство пользователя                 17 
 
4. Если определение прошло успешно, на экране появится  OwnZone Updated (OwnZone обновлена) и зона 

появится на дисплее. Зона демонстрируется в виде числа уд./мин, процента от максимального 
сердечного ритма (HR%) или процента резерва сердечного ритма (HRR%) в зависимости от ваших 
настроек.  

5. Если определение OwnZone прошло неудачно, будет использоваться ваша предыдущая OwnZone и на 
экране появится  OwnZone Limits (лимиты OwnZone). Если OwnZone ранее не была записана, будут 
автоматически задействованы возрастные ограничения. 

 
Теперь вы можете продолжить упражнение. Для получения максимальной пользы от упражнения старайтесь 
держаться в рамках границ зоны сердечного ритма. 
 
Для альтернативного определения OwnZone и использования ранее определенной OwnZone нажмите на ОК в 
любой момент упражнения. 
  

 Истекшее время, употребленное на определение OwnZone, включается во время записываемого 
упражнения.  

 
* Здесь требуется опциональный датчик s3 Stride Sensor W.I.N.D. 
 
6.  ПОСЛЕ ТРЕНИРОВКИ 
 
Прекращение записи 
 
Пауза в записи упражнения устанавливается нажатием на STOP. Для полной остановки записи нажмите на 
STOP еще раз. 
 
После упражнения позаботьтесь о передатчике. После использования снимите передатчик с ремешка. 
Содержите передатчик чистым и сухим. Инструкции по уходу и обслуживанию см. в разделе «Уход и 
обслуживание». 
 
Анализ результатов упражнения  

 
Для ознакомления с результатами упражнения см. File на вашем беговом компьютере. Для более глубокого 
анализа перенесите данные на Polar ProTrainer5. Программное обеспечение предоставляет различные 
варианты проведения анализа. 
 
Беговой компьютер и программное обеспечение соединены через стандарт IrDA (инфракрасная передача 
данных и вывода на печать – прим. перев.). Для начала откройте программное обеспечение. Выберите 
Connect (соединить) на вашем беговом компьютере и положите датчик перед инфракрасным портом 
компьютера. Подробнее о передаче данных см. в разделе о программном обеспечении. 
 
Выберите File для следующих опций: 
 
• Exercise log: вмещает до 99 файлов упражнений.  
• Weekly: включает краткую информацию о последних 16 неделях. 
• Totals: показывает сводную информацию об упражнениях.  
• В меню Delete можно удалять файлы с упражнениями. 
 
Exercise Log (журнал упражнений) 
 
Выберите File > Exercise Log 

 
В Exercise Log можно видеть подробную информацию о сеансах ваших упражнений. Там появляется 
следующая информация: 
• Название упражнения. 
• Графическое изображение сеансов упражнений. По высоте полосы указывается продолжительность 

упражнения. Это - изменение сеансов ваших тренировок в графическом изображении.  
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• Дата, когда вы выполнили упражнение. 
 
Информация, которую можно видеть (пункты а-г ниже) зависит от типа упражнения и настроек (например, 
если ваше упражнение не содержит циклов, информация о них будет недоступна). 
 
Нажатием на UP и DOWN «пройдитесь» по полосам упражнений и нажмите ОК, чтобы видеть: 
 

 

 
 

 
 
 

 
 
 

 

 
а. Basic (базовый). 
 
Выберите File>Exercise log>Basic 
 
 
 

 
 
б. Sport zones (спортзоны). 
 
Выберите File>Exercise log>Sport zones 
 
 
 

 
 
в. Phases (циклы). 
 
Выберите File>Exercise log>Phases 
 
 
 

 
 
г. Laps (круги). 
 
Выберите File>Exercise log>Laps 
 
 

 
а. Basic.  
 
Выберите File>Exercise log>Basic  
 

 

 

 
Название упражнения 
 
Время начала 
 
Дистанция* 
 
Продолжительность 

 
Нажмите ОК и нажатием на UP и DOWN пройдитесь, чтобы видеть:

 

 
 

 

 
Heart rate (сердечный ритм) в уд./мин или в % от макс. сердечного ритма 
 
Макс. сердечный ритм 
 
Мин. сердечный ритм 
 
Средний сердечный ритм 
 
Target zones (сердечный ритм/скорость/темп), альтернативно зона 1, зона 2, зона 3 
 
Верхняя граница 
 
Нижняя граница 
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Time in, above, and below zone 1/2/3 (время в, сверх и до зон 1/2/3; название цикла  
выводится на дисплей в запрограммированном упражнении). 
 
Время выше зоны 
 
Время ниже зоны 
 
Время в зоне 
 
Speed/pace* 
 
Максимальная скорость/темп 
 
Средняя скорость/темп 
 
Дистанция* 
 
Для переключения скорости/темпа нажмите и удерживайте LIGHT. 
 
Calories (калории, израсходованные во время упражнения). 
 
Расход энергии указывает на общую нагрузку во время упражнения. 
 
 
 
Running Index (беговой коэффициент) 
 
Для того, чтобы получить цифровое изображение бегового коэффициент, ваше 
упражнение должно полностью соответствовать определенным требованиям. 
Подробнее см. в  разделе «Беговой коэффициент Polar». 
 

 
Altitude (высота над уровнем моря) 
 
Максимальная 
 
Минимальная 
 
Средняя 
 
Ascent (подъём) 
 
Высота подъема в м/футах 
 
 
 
 
 
Cadence* (частота шагов, показывается на дисплее в виде количества шагов/мин) 
 
Макс. частота шагов 
 
Средняя частота шагов 
 
 
 
Stride length* (длина шага) 
 
Средняя длина шага 
 
 

Для возврата в основное информационное меню нажмите STOP. 
 
Дополнительная базовая информация 
 
Выберите File>Exercise log>Basic 
 
Для того чтобы добавить вашу собственную информацию об упражнении или удалить ее из file, нажмите и 
удерживайте LIGHT в основном информационном меню. 

 
• Rank: присвойте вашему упражнения степень. 
• Feeling: оцените ваши субъективные ощущения во время упражнения. 
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• Temperat: установите температуру нажатием на UP и DOWN. 
• Distance: если вы случайно установили для вашего упражнения неправильную обувь и дистанция, 

соответственно, оказалась рассчитанной также на неправильную обувь, вы можете здесь 
скорректировать обувь и записать дистанцию.  Выберите обувь, которая была на вас во время 
упражнения, после чего введите дистанцию. Дистанция корректируется исходя из выбранной обуви, а 
также в журналах общей и недельной дистанции. Вы также можете ввести здесь дистанцию, если 
выполняли упражнение без датчика шага. Выберите Other (другой), чтобы записать дистанцию, которую 
вы не хотите предназначать для обуви 1 и 2. 

 
б. Sport zones (спортзоны) 

 
 
Выберите File>Exercise log>Sport zones 
 
Для того чтобы увидеть информацию о Sport zones в основном информационном меню нажмите DOWN. 

 
 
Для того чтобы увидеть время, проведенное в каждой из зон, нажмите ОК и прокрутите нажатием на UP или 
DOWN. Здесь показано изменение сеансов ваших тренировок в графическом формате.  
 
Нажмите на STOP, чтобы вернуться в информационный вид Sport zones. 
 
в. Phases (циклы).  

 
 
Выберите File>Exercise log>Phases 
 
Меню Phases выводится на дисплей только в том случае, если упражнение создано в программном 
обеспечении и включает циклы. 
 
В информационном виде Sport zones нажмите  DOWN, чтобы видеть информацию о циклах. Каждый цикл 
можно видеть отдельно. 
 
Для прокрутки данных по отдельному циклу используйте кнопку ОК. Сравнение циклов проводите нажатием 
на UP и DOWN. 
 

 

 
 
 

 

 
Time (время) 
 
Название цикла 
 
Разделенное время 
 
Продолжительность текущего цикла 
 
Heart rate (сердечный ритм) в уд./мин или в % от макс. сердечного ритма. 
 
Макс. сердечный ритм 
 
Средний сердечный ритм 
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Increased HR / Recovery HR / HR differ (увеличенный сердечный ритм 
/восстановительный сердечный ритм /различие в сердечном ритме) 
 
Различие в сердечном ритме в начале и конце цикла. Текущий сердечный ритм в уд./мин 
или в % от макс. сердечного ритма. 
 
Increased HR: если сердечный ритм был ниже в начале цикла, чем в конце, беговой 
компьютер покажет разницу в сердечном ритме (сердечный ритм в конце минус сердечный 
ритм в начале). В рабочем цикле беговой компьютер покажет значение увеличенного 
сердечного ритма. 
 
Recovery HR: если сердечный ритм был выше в начале цикла, чем в конце, беговой 
компьютер покажет разницу в сердечном ритме (сердечный ритм в начале минус 
сердечный ритм в конце). В восстановительном цикле беговой компьютер покажет 
значение восстановительного сердечного ритма. 
 
HR differ: если сердечный ритм в начале и конце цикла был одинаковым, беговой 
компьютер покажет нулевую разницу в сердечном ритме. 
 
Speed/pace* 
 
Максимальная скорость/темп 
 
Средняя скорость/темп 
 
 
Distance* 
 
Разделенная дистанция 
 
Дистанция текущего цикла 
 
 

 
 
Cadence*  
 
Макс. частота шагов 
 
Средняя частота шагов 
 
 
Stride length*  
 
Средняя длина шага в текущем цикле 
 

 
Нажмите на STOP, чтобы вернуться в информационный вид Phases. 
 
г. Laps (круги)  
 
Выберите File>Exercise log>Laps 
 
В информационном виде Phases нажмите кнопку DOWN, чтобы видеть информацию о Laps (кругах). Она 
доступна только в случае, если в памяти заложено более одного круга.  
 

 

 

 
Число записанных кругов 
 
Среднее время круга 
 
Номер лучшего (самого быстрого) круга и его время. 
 

 
 Последний круг никогда не показывается как лучший, даже если он самый быстрый. Если вы выполня-
ете беговое упражнение и хотите включить ваш последний круг, на финишной черте вместо STOP 
нажмите ОК. В этом случае последний круг будет включен в расчет лучшего круга. Вы можете 
прекратить запись после финишной черты. 
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Нажатием на ОК прокрутите различную информацию по отдельному кругу. 
 
Нажатием на UP и DOWN сравните информацию по разным кругам. 
 
Для того чтобы облегчить просмотр информации по кругам, передайте файлы в программное обеспечение. 
 

 

 
 

 
 

 
 
 

 
 

 
 

 
 

 
 

 
Time (время) 
 
Разделенное время 
 
Время круга 
 
 
 
Heart rate (сердечный ритм) в уд./мин или в % от макс. сердечного ритма. 
 
Макс. сердечный ритм 
 
Средний сердечный ритм 
 
Сердечный ритм в конце круга 
 
Speed/pace* 
 
Средняя скорость/темп 
 
Скорость/темп в конце круга 
 
Для переключения скорости/темпа нажмите и удерживайте LIGHT. 
 

 
Distance* 
 
Дистанция, пройденная до момента начала следующей фазы 
 
Дистанция круга 
 
 
Cadence*  
 
Макс. частота шагов 
 
Средняя частота шагов 
 
 
 
Stride length*  
 
Средняя длина шага в круге 
 
 
 
 
Altitude (высота над уровнем моря) 
 
Подъём 
 
Высота над уровнем моря в круге 
 
 
 

 
Нажмите на STOP, чтобы вернуться в информационный вид Laps. 
 
* Здесь требуется опциональный датчик s3 Stride Sensor W.I.N.D. 
 
Краткие итоги недели 
 
Выберите File >Weekly. 
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В кратких итогах недели Weekly вы можете видеть данные, накопленные за 16 недель упражнений. Полоса 
справа называется This week (эта неделя) и показывает краткие итоги текущей недели. Предыдущие полосы 
датированы воскресеньем данной недели. Нажатием на UP и DOWN прокрутите недели на дисплее и 
просмотрите общую продолжительность упражнений на нижней полосе. 
 

 
Выберите неделю нажатием на ОК, чтобы увидеть общее число калорий, дистанцию* и время упражнения. 
Нажмите на DOWN, чтобы посмотреть недельные спортзоны. 
 

 
Нажмите на ОК и нажатием на UP и DOWN прокрутите спортзоны, чтобы увидеть время, проведенное в 
каждой из них. 
 
Totals (итоги) 
 
Выберите  File > Totals. 
 
Totals включают сводную информацию, записанную за время сеансов упражнений после последнего сброса 
данных. Используйте данные файла для расчета годовых или месячных данных тренировок. После того как 
запись упражнения прекращается, цифры автоматически обновляются.  
 
Нажатием на UP и DOWN прокрутите следующую информацию: 
 
• Дистанция обуви 1 или обуви «Адидас»* 
• Дистанция обуви 2* 
• Дистанция* - всего 
• Общая продолжительность 
• Калории – всего 
• Общая длина подъема 
• Сброс итоговых данных 
 
Для сброса итогов выберите File > Totals > Reset totals (файл>итоги>сброс итогов). 
 
Выберите величину, которую вы хотите сбросить из меню, и подтвердите ОК. Команду на сброс подтвердите 
выбором Yes. Удаленную информацию уже нельзя будет найти. Для возврата в меню Reset выберите No. 
 
Удаление файлов 
 
Выберите File > Delete > Totals.  
 
В Delete вы можете удалить предыдущие упражнения один за другим, все разом или удалить итоговые 
данные.  
 
Нажатием на UP и DOWN прокрутите следующую информацию: 
 
• Exercise: выберите одно упражнение для удаления 
• All exerc.: удалите из памяти все упражнения одним нажатием на кнопку 
• Totals: удалите итоговые данные один за другим или все разом. 
 

Подтвердите выбором Yes. 
 
* Здесь требуется опциональный датчик s3 Stride Sensor W.I.N.D. 
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7.  НАСТРОЙКИ  
     
Настройки параметров 
 

 
Stride Sensor* (датчик шага) 
 
С помощью датчика беговой компьютер может измерять скорость/темп, дистанцию и ритм. Измените 
настройки вашего датчика шага в меню S sensor. 
 
Переведите функцию скорости и дистанции на Вкл или Выкл. 
 
Выберите Settings > Features > S sensor > On/Off (настройки > параметры > датчик > Вкл/Выкл). 
 
Откалибруйте датчик шага. 
 
Выберите Settings > Features > S sensor > Calibrate (настройки > параметры > датчик > калибровка). 
 
Подробнее см. в разделе о калибровке датчика шага. 
 
Использование нового датчика*. 
 
Выберите Settings > Features > S sensor > New sensor (настройки > параметры > датчик > новый датчик). 
 
При использовании нового датчика шага*, он должен быть введен в беговой компьютер. Это называется  
«обучение». Подробнее см. в разделе «Обучение нового датчика шага».  
 
Сброс всех датчиков шага*. 
 
Выберите Settings > Features > S sensor > Remove all (настройки > параметры > датчик > удалить все). 
 
Все датчики шага можно сбросить в памяти бегового компьютера. 
 
Высота над уровнем моря 
 
Беговой компьютер измеряет и выводит на дисплей высоту. В меню Altitude измените настройки альтиметра. 
Калибровку альтиметра можно осуществить автоматически или вручную.   
 
Установите функцию альтиметра на Вкл/Выкл. 
 
Выберите Settings > Features > Altitude > On/Off (настройки > параметры > альтиметр > Вкл/Выкл). 
 
Ручная калибровка альтиметра. 
 
Выберите Settings > Features > Altitude > Calibrate (настройки > параметры > альтиметр > калибровать) и 
установите высоту места, где вы находитесь. 
 
Если эта высота существенно отличается от величины на дисплее, на его экране появляется Calibrate to xx? 
(откалибровать по хх?). 
 
• Yes: высота, откалиброванная по хх показывается на дисплее 
• No: на дисплее показывается информация об отмене калибровки высоты (Altitude calibration cancelled). 

При этом применяется последняя величина высоты, сохраненная в беговом компьютере. 
 
Проводите калибровку высоты до тех пор, пока она не станет точной. Установите справочную величину 
высоты, когда имеются надежные справочные данные, такие как обозначенная на топографической карте 
величина высоты, или когда вы находитесь на уровне моря.  
 
Автоматическая калибровка высоты. 
 
Выберите Settings > Features > Altitude > AutoCalib >On/Off (настройки > параметры > альтиметр > 
автокалибровка>Вкл/Выкл). 
 
При включенном режиме автокалибровки (AutoCalib On) во время выполнения упражнения применяется 
последняя величина высоты, сохраненная в беговом компьютере. Эта особенность особенно полезна, если 
вы всякий раз начинаете сеанс в одних и тех же условиях. Если автокалибровка не получается, это означает, 
что вы находитесь не в обычных условиях, поэтому потребуется ручная калибровка.     
 
Фраза на дисплее Altitude calibrated to xx указывает на успешность проведенной калибровки, а Altitude 
calibration failed – требует повторной калибровки.  



Фирменный магазин PolarSport.ru

Polar RS800 Руководство пользователя                 25 
 
 
 
Скорость записи 
 
Выберите Settings > Features > Rec. rate > 1/5/15/60 sec (настройки > параметры > скорость записи > 
1/5/15/60 сек) 
 
Беговой компьютер может сохранять ваш сердечный ритм, скорость/темп* и высоту над уровнем моря с 
интервалами в 1/5/15/60 сек. Более продолжительные интервалы удлиняют время записи, в то время как 
более короткие позволяют вести более продолжительную запись сердечного ритма и других данных. Это 
предоставляет возможность для более точного анализа данных с помощью программного обеспечения. 
 
Более короткие интервалы записи быстрее поглощают память бегового компьютера. Остающееся время 
записи показывается в нижнем ряду при установке интервала. Интервал по умолчанию – 5 сек. 
 
Когда остается менее 30 мин времени записи, интервал записи автоматически меняется на более 
продолжительный (1>5>15>60). Это позволяет максимизировать время записи данных упражнения. По 
окончании сеанса  установленный интервал остается по умолчанию. 
 
В таблице ниже показано максимальное время записи для каждого интервала. Помните об изменении 
интервала, когда остается менее 30 мин времени записи. 
 
Скорость Скорость Высота  Скорость Скорость Скорость Скорость 
записи  /темп    записи 1 с записи 5 с записи 15 с записи 60 с 
 
Выкл  Выкл  Выкл  31 ч 30 м 158 ч**  474 ч**  1899 ч** 
 
Выкл  Выкл  Вкл  10 ч 30 м 54 ч 40 м 158 ч  633 ч 
 
Выкл  Вкл  Выкл  6 ч 10 м  31 ч 30 м 79 ч  316 ч 
 
Выкл  Вкл  Вкл  4 ч 30 м  22 ч 30 м 59 ч 20 м 237 ч 
 
Вкл  Вкл  Выкл  18 ч 50 м 18 ч 50 м 18 ч 50 м 18 ч 50 м 
 
Вкл  Выкл  Вкл  8 ч 30 м  15 ч 10 м 17 ч 30  м 18 ч 30 м 
 
Вкл  Вкл  Выкл  5 ч 30 м  12 ч 30 м 15 ч 40 м  18 ч 
 
Вкл  Вкл  Вкл  4 ч  11 ч  14 ч 50 м 17 ч 40 м 
 
 
** - это сумма 2 и более упражнений; макс. продолжительность одного упражнения составляет 99 ч 59 м 59 с. 
Макс. время записи может быть меньше, если вы записываете большое количество коротких упражнений. 
 

 Продолжительность в таблице носит оценочный характер. Для показателя скорости записи макс. 
время записи зависит от сердечного ритма и его изменения. Если в своем упражнении вы записываете 
круги и/или вы с помощью программного обеспечения создали упражнение, которое включает циклы, 
максимальное время записи увеличится.  

 
При переполнении памяти запись автоматически не прекращается. Поэтому время упражнения может быть 
продолжительнее времени записи. 
 
Функция данных скорости записи 
 
Выберите Settings > Features > RR data / On/Off (настройки > параметры > скорость записи/Вкл/Выкл).  
 
Функция данных скорости записи измеряет и записывает изменения числа ударов сердца с разрешением в 
миллисекунду. Это позволяет делать анализ изменения сердечного ритма (HRV)(с точностью 1 мс) с 
помощью программного обеспечения. Функция данных скорости записи «поглощает» память бегового 
компьютера, поэтому при ее установке на нижнем ряду дисплея появляется остающееся время записи.   
 
Обувь 
 
Выберите обувь для своего упражнения. 
 
Выберите Settings > Features > adidas > Shoes 2 / Other (настройки > параметры > Адидас >обувь 2/другая). 
 
Для того чтобы отслеживать и сравнивать результаты использования различной обуви, беговой компьютер 
может сохранять дистанцию* бега для различных пар обуви. 
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Задайте вашей обуви новое имя.  
 
Выберите Settings > Features > adidas / Shoes 2 > Rename (настройки > параметры > Адидас / обувь 2 > 
переименовать). 
 
Название напечатайте с помощью UP, DOWN, OK. 
 
Выберите тип вашего датчика*. 
 
Выберите Settings > Features > adidas / Shoes 2 > Sensor type > Integrated/Shoelaces (настройки > 
параметры > Адидас / обувь 2 >тип датчика> вставленный под стельку/на шнурках). 
Integrated - датчик шага находится в специальном углублении под стелькой (для этого требуется 
специальная обувь). Shoelaces – датчик шага прикреплен к шнуркам.  
 
При установке датчика шага в специальном углублении под стелькой и прикреплении его к шнуркам 
происходит некоторая дифференциация измеренной длины дистанции. Для получения самых точных 
результатов рекомендуется проводить калибровку датчика при каждой смене его местоположения. 
Подробнее см. в разделе «Калибровка датчика шага». 
 

Использование другой обуви. 
 
Выберите Settings > Features > Shoes  > Other (настройки > параметры > обувь > другая). 
 
Беговые дистанции аккумулируются только в файлах Total и Weekly и не связаны с определенной обувью.  
 

 Начиная запись упражнения, вы можете легко изменить выбор обуви. В режиме времени нажмите ОК, 
нажмите и удерживайте DOWN. Число в нижнем правом углу дисплея указывает выбор обуви. 

 
Вид скорости* 
 
Выберите Settings > Features > Speed view  > km/h (mph) or min/km (настройки > параметры > показ 
скорости > км/ч (миль/ч) или мин/км). 
 
Автоматическая запись круга* 
 
Установите автоматическую запись круга, для чего выберите  Settings > Features > A.Lap  > On > set the lap 
distance (настройки > параметры > круг А > Вкл > установить дистанцию круга). 
 
Беговой компьютер будет автоматически вести запись кругов. Для отключения нажмите Off. 
 
Вид сердечного ритма 
 
Определите то, как на дисплее будет показан сердечный ритм, для чего выберите Settings > Features > HR 
view > HR / HR%/HRR% (настройки > параметры > вид сердечного ритма > сердечный ритм / сердечный ритм 
%/резерв сердечного ритма %). 
 
Спортзоны 
 
Определите спортзоны на беговом компьютере, для чего выберите Settings > Features > Sport zones > Sport 
zone low limit (настройки > параметры > спортзоны > нижняя граница спортзоны). 
 
Установите нижнюю границу спортзоны 1 нажатием на UP и DOWN. После этого нажмите ОК. Установите 
таким же путем нижнюю границу каждой спортзоны. При установке нижней границы верхняя граница 
предыдущей зоны устанавливается автоматически. 
 
Нажмите и удерживайте LIGHT, чтобы переключаться между видами  зон, выраженными в HR% или ВРМ 
(уд./мин) или HRR%.     
 

 Настройки можно менять, используя программное обеспечение. Подробнее см. в разделе о программном 
обеспечении. 

 
* Здесь требуется опциональный датчик s3 Stride Sensor W.I.N.D. 
 

Настройки пользователя 
 
Установите в беговой компьютер точную информацию  пользователя, чтобы в ответ получать правильные 
данные о физической форме.  
 
Для ввода информации в беговой компьютер  
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выберите Settings > User (настройки > пользователь). 
 

 
 
• Weight: вес; для изменения единиц измерения нажмите LIGHT  
• Height: рост; для изменения единиц измерения нажмите LIGHT  
• Birthday: дата рождения (dd= день , mm= месяц , yy= год ) 
• Sex: пол (male/female – м/ж) 
• Activity: активность (Top/High/Moderate/Low – высшая/высокая/средняя/низкая) 
• Heart Rate: сердечный ритм (max, sit – макс., в положении сидя) 
• VO2max: макс. объем вдыхаемого кислорода 
 
Уровень активности 
 
Уровень активности – это оценка уровня вашей физической активности в течение продолжительного времени. 
Выберите вариант, который лучше всего отражает общий объем и интенсивность вашей физической 
активности за последние три месяца.  
 
• Тор: вы участвуете в тяжелых физических упражнениях не менее 5 раз в неделю или делаете 

упражнения, чтобы повысить свою спортивную форму к соревнованиям. 
• High: вы участвуете в тяжелых физических упражнениях не менее 3 раз в неделю, например, пробегаете 

10-40 км в неделю или проводите по 2-4 часа в неделю, занимаясь соизмеримыми по нагрузкам 
физическими упражнениями. 

• Moderate: вы регулярно занимаетесь рекреационными видами спорта, например пробегаете 5-10 км в 
неделю или получаете соизмеримые нагрузки, или ваша работа требует средних физических нагрузок. 

• Low: вы регулярно не занимаетесь рекреационными видами спорта или не получаете тяжелые 
физические нагрузки, а, например, совершаете прогулки для удовольствия или делаете тяжелые 
упражнения, вызывающие учащенное дыхание, только от случая к случаю. 

 
Беговой компьютер использует указанные величины для расчета расхода энергии. 
 
Heart Rate: HRmax, HRsit 
 
HRmax (макс. сердечный ритм): показатель вашего макс. сердечного ритма (220-возраст) используется по 
умолчанию. Если ваш макс. сердечный ритм был определен лабораторно или вы определили его сами, 
введите его вручную. 
 
HRsit (сердечный ритм в сидячем положении): этот показатель используется по умолчанию. Установите 
сердечный ритм в сидячем положении, если определили его, следуя инструкции, которые содержатся в 
разделе «Сердечный ритм в сидячем положении». 
 
Макс. объем вдыхаемого кислорода -VO2max – во время максимального напряжения. Наиболее точно 
данный показатель может быть определен в лабораторных условиях. Если он вам известен, установите его в 
беговой компьютер. Или измерьте этот показатель в ходе Polar Fitness Test (фитнес-теста Polar). См. 
соответствующий раздел. 
 
Если в настройки пользователя вносятся изменения, на дисплее появляется User settings updated 
(настройки пользователя откорректированы).    
 

 Настройки можно менять, используя программное обеспечение. Подробнее см. в разделе о программном 
обеспечении. 

 

Общие настройки 
 

 
 
Звук 
 
Для установки уровня звука 
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выберите Settings > General > Sound > On/Off (настройки>общие>звук>Вкл/Выкл).  
 
Во время упражнения кнопка управления настройкой звука издает звук, как и кнопка активности, что, однако, 
не влияет на часы и звуковой сигнал целевой зоны (TZ Alarm). 
 
Для Вкл/Выкл звукового сигнала целевой зоны  
 
выберите Settings > General > Sound > TZ Alarm > On/Off (настройки>общие>звук> звуковой сигнал целевой 
зоны >Вкл/Выкл).  
 
Когда вы выходите за пределы целевой зоны, звуковой сигнал целевой зоны отключается, а на дисплее 
начинают мигать лимиты. Если звук отключен, а звуковой сигнал целевой зоны все еще включен, последний 
будет работать. 
 
Keylock (блокировка (разблокировка) кнопок от случайного нажатия) 
 
Определите настройку Keylock, для чего  
 
выберите Settings > General > Keylock > Manual/Automatic (настройки>общие> Keylock 
>ручная/автоматическая).  
 
• Manual: активирует ручной режим блокировки. Для Вкл/Выкл блокировки нажмите LIGHT и удерживайте 

не менее 1 сек. 
• Automatic: блокировка активируется в режиме времени, когда на кнопки не нажимали 1 мин.  
 
Units (ед. изм.) 
 
Установите предпочтительные ед. изм., для чего  
 
выберите Settings > General > Units > kg/cm or lb/ft/mi (настройки>общие> ед. изм. >км/см или 
фунты/футы/мили). 
 
Language (язык)  
 
Выберите язык, для чего  
 
выберите Settings > General > Language > English/Deucth/Espanol/Francais (настройки>общие> язык). 
 
Sleep (режим ожидания) 
 
Активируйте режим ожидания, для чего  
выберите Settings > General > Sleep > Activate sleep mode? > Yes (настройки>общие> активировать режим 
ожидания? >да). 
 
Активирование режима ожидания поможет сохранить заряд батарейки, когда беговой компьютер не 
используется в течение длительного времени. В режиме ожидания функция будильника продолжает 
работать.  
 
Для «пробуждения» бегового компьютера  
 
Нажмите на любую кнопку, после чего на дисплее появится Turn display on? > Yes/No (включить дисплей? > 
да/нет). 
 
• Yes: беговой компьютер активирован 
• No: беговой компьютер возвращается в режим ожидания. 
 

 Настройки можно менять, используя программное обеспечение. Подробнее см. в разделе о программном 
обеспечении. 

 

Настройки часов 

 
Устройство напоминания 
 
Установите устройство напоминания, чтобы получать напоминания о различных задачах и упражнениях. Для 
этого выберите Settings > Watch > Reminders > Add new (настройки>часы> устройство напоминания > 
добавить новый). 
• Date: введите дату задания:  dd = день, mm = месяц, уу = год. 
• Reminder time: введите время для задания. 
• Alarm: установите звуковой сигнал на время задания, или за 10 мин/30 мин / 1 час до него. 
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• Sound: установите тип звукового сигнала (Silent/Beep/Normal – без звука/одинарный/повторяющийся). 
• Repeat: установите периодичность сигнала устройства напоминания (Once/Weekly/Monthly/Yearly – 1 

раз/раз в неделю/раз в месяц/ раз в год). 
• Exercise: выберите упражнение, связанное с устройством напоминания. Когда устройство напоминания 

выключается, беговой компьютер будет представлять данное упражнение по умолчанию. Если вы не 
хотите связывать устройство напоминания с сеансом упражнений, выберите NONE.  

• Rename: для переименования устройства напоминания выбирайте буквы с помощью UP и DOWN и 
подтверждайте выбранное нажатием на ОК. 

 
На беговом компьютере можно запрограммировать 7 напоминаний. 
 
Просмотрите действующие напоминания и измените их, для чего  
 
выберите Settings > Watch > Reminders (настройки>часы> напоминания).  
 
Выберите напоминание для вида, редактирования, переименования или удаления.  
 
Вид упражнений 
 
Установите обратный отсчет вида упражнений на беговом компьютере. 
 
Выберите  Settings > Watch > Event (настройки>часы> вид упражнений). 
 
Event day (день для вида упражнений): dd = день, mm = месяц 
 
Rename: для переименования выбирайте буквы с помощью UP и DOWN и подтверждайте выбранное 
нажатием на ОК. 
 
Измените обратный отсчет вида упражнений, для чего выберите Settings > Watch > Event. 
 
Вы можете видеть обратный отсчет вида упражнений, установить новую дату, переименовать или удалить 
его.  
 
В этом режиме выводить на экран или удалять с экрана обратный отсчет вида упражнений можно нажатием и 
удержанием кнопки UP. 
 
Alarm (звуковой сигнал тревоги)  
 
Установите звуковой сигнал тревоги на беговой компьютер, для чего  
 
выберите Settings > Watch > Alarm > Off/Once/Mon-Fri/Daily (настройки>часы> звуковой сигнал тревоги > 
Выкл/ 1 раз/ пон-пят/ежедневно). 
 
Вы можете установить подачу звукового сигнала тревоги 1 раз в день, каждый день с понедельника по 
пятницу или ежедневно. Сигнал звучит на всех режимах, кроме режима упражнений, в течение минуты, пока 
не нажмете кнопку STOP. Будильник работает также в режиме ожидания. Звуковой сигнал тревоги будет 
звучать, даже если вы выключите звук в режиме общих настроек. 
 
Для того чтобы звуковой сигнал тревоги повторился еще в течение 10 мин, нажмите UP и DOWN или ОК – на 
дисплее появится Snooze и начнется отсчет времени. Для отмены данной функции и режима звукового 
сигнала тревоги нажмите STOP. 
 

 Если на дисплее появился символ батарейки, активировать звуковой сигнал тревоги невозможно. 
 
Время 
 
Установите на беговом компьютере время 1, для чего  
 
выберите Settings > Watch > Time 1 > 24h/12h (настройки>часы> время 1> 24 ч/ 12 ч). 
 
Установите на беговом компьютере время 2, для чего  
 
выберите Settings > Watch > Time 2. 
 
Установите разницу в часах между временем 1 и 2. 
 
Осуществите переключение между часовыми поясами, для чего  
 
выберите Settings > Watch > Time zone > Time 1/ Time 2. 
 
Выберите часовой пояс. 
 
В режиме времени измените часовой пояс, нажав и удерживая кнопку DOWN. Цифра 2 в нижнем правом углу 
дисплея указывает, что используется время 2.  
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Дата 
 
Установите на беговом компьютере дату, для чего  
 
выберите Settings > Watch > Date (настройки>часы> дата).  
 
dd = день, mm = месяц, уу = год 
 

 Настройки можно менять, используя программное обеспечение. Подробнее см. в разделе о программном 
обеспечении. 

 
Персонифицирование бегового компьютера во время тренировки 
 
В режиме времени выберите ОК > Settings > Watch > Edit (настройки>часы>редактировать). 
 
Персонифицируйте дисплей вашего бегового компьютера, чтобы он показывал ту информацию, которую вы 
хотите видеть, используя для этого либо сам беговой компьютер, либо программное обеспечение. 
Запрограммированное упражнение из программного обеспечения имеет свое изображение на дисплее, 
которое не поддается корректировке.  
 
Подробнее о символах на дисплее, см. в «Информация на дисплее». 
 
Выберите изображение на дисплее, которое вы хотите изменить, нажимая UP и DOWN или ОК. Нажимая UP и 
DOWN, установите это изображение в верхний мигающий ряд. Изображение на дисплее зависит от того, 
какие параметры активированы. Подробнее см. в «Настройки параметров». 
 
Повторите эту же операцию для изменения среднего и нижнего рядов. После того как информация попадает в 
нижний ряд на дисплее, она получает название. Для возврата в меню настроек по умолчанию нажмите и 
удерживайте LIGHT во время мигания рядов.   
 
Активируйте Titles (названия), чтобы видеть вспомогательные тексты при изменении изображения на дисплее 
во время упражнения. В режиме времени выберите ОК > Settings > Display > Titles. 
 
Кнопка быстрого выбора команд (быстрое меню) 
 
Некоторые настройки можно изменить кнопкой быстрого выбора команд в меню времени. Для этого нажмите 
и удерживайте LIGHT > Quick menu  (LIGHT > быстрое меню): 
 
• Keylock: (блокировка (разблокировка) кнопок от случайного нажатия) 
• Reminders: (устройство напоминания) 
• Alarm: (звуковой сигнал тревоги)  
• Time zone: (временная зона) 
• Sleep: (режим ожидания) 
  
Подробнее см. на стр. 7. Settings. 
 
8.  ПРОГРАММА ТРЕНИРОВКИ 
 
Вид программы 
 
Вы можете создать и загрузить в беговой компьютер персонифицированную программу тренировки, 
используя Polar ProTrainer5. В данном разделе содержатся основные инструкции, как находить и как 
пользоваться программой, которую вы загрузили в ваш беговой компьютер. Подробнее о создании 
упражнения с помощью программного обеспечения, передаче его на беговой компьютер, анализе вашей 
физической формы после тренировок см. в разделе о Polar ProTrainer5.     
 
После загрузки программы в беговом компьютере создается два специальных меню, на которых вы можете 
видеть вашу программу и сверяться со своим дневным графиком. Нажимая UP или DOWN, прокрутите 
недели, дни и упражнения. Выберите неделю и день кнопкой ОК. 

 Today – сегодня 
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Вид недельной программы. 
 
Выберите Program > Week view (программа>вид недели).   
 
Вид недели предоставляет возможность получить обзор упражнений за неделю. Белая полоса означает 
время плановых упражнений, черная полоса – реально затраченное время. Под полосами показано 
недельное целевое время упражнения.  
 
Нажмите и удерживайте LIGHT, чтобы увидеть следующую недельную информацию: 
 
• Week info (недельная информация): название недели и ее описание. 
• Targets: краткий обзор целей на неделю. Калории, дистанция* и продолжительность. Плановое время 

для спортзон – нажмите ОК и «пройдитесь» между спортзонами, нажимая UP и DOWN. 
• Results: краткий обзор результатов за неделю. Калории, дистанция* и продолжительность. Выполненное 

время в спортзонах – нажмите ОК и «пройдитесь» между спортзонами, нажимая UP и DOWN. 
• Reminder: установите звуковой сигнал (на время, за 10/30/60 минут до упражнения) и определите тип 

сигнала (Silent/Beep/Normal – без звука/одинарный/повторяющийся). 
• Program off: удаление программы из бегового компьютера. 
 
Вид дневной программы. 
 
Выберите Program > Week view > Day view  (программа>вид недели> просмотр дня). 
 
Выберите Today > Exercise view (сегодня> вид упражнения). 
 
Просмотр дня предоставляет возможность получить обзор упражнений за день. Белая полоса означает время 
плановых упражнений, черная полоса – реально выполненное время. Под полосами показано целевое время 
дня для упражнений.  
 
Нажмите и удерживайте LIGHT, чтобы увидеть следующую информацию о дне: 
 
• Targets: краткий обзор целей за день. Калории, дистанция* и продолжительность. Плановое время для 

спортзон – нажмите ОК и «пройдитесь» между спортзонами, нажимая UP и DOWN. 
• Results: краткий обзор результатов за день. Калории, дистанция* и продолжительность. Выполненное 

время в спортзонах – нажмите ОК и «пройдитесь» между спортзонами, нажимая UP и DOWN. 
 
Вид упражнений за день.  
 
Выберите Program > Week view > Day view  > Exercise view. 
 
Вид упражнений показывает следующую информацию: название упражнения, описание и целевую 
продолжительность. 
 
Нажмите и удерживайте LIGHT, чтобы увидеть следующую дневную информацию: 
 
• Targets: краткий обзор целей за сеанс упражнений. Калории, дистанция* и продолжительность. 

Плановое время для спортзон – нажмите ОК и «пройдитесь» между спортзонами, нажимая UP и DOWN. 
• Phases: краткий обзор циклов за сеанс упражнений. 
• Sport profile: вид и название выбранного спортивного профиля. Подробнее см. в разделе о 

программном обеспечении. 
• Reminder: установите время для устройства напоминания. 
 
* Здесь требуется опциональный датчик s3 Stride Sensor W.I.N.D. 
 

Выполнение запрограммированного упражнения 
 
Начало тренировки 
 
Если вы установили функцию напоминания, беговой компьютер напомнит вам о необходимости проведения 
тренировки в день согласно графику. Когда срабатывает устройство напоминания, проверьте информацию о 
плановых упражнениях, нажав ОК. 
 
Начинайте упражнения дня, выбрав Today > Exercise view > нажмите ОК > нажмите ОК. 
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Выберите Program > Week view > Day view  > нажмите ОК > нажмите ОК. 
 
Подробнее см. в разделе «Начало тренировки». Ваш беговой компьютер предоставит необходимые 
инструкции по сеансу тренировки. 
 
Выполнение упражнения с циклами 
 
Ниже показан пример упражнения с интервалами, состоящего из 4 циклов. 
 
Warm up/P1– разминка/Ц1: 10-минутный бег при сердечном ритме 55-65% от макс. сердечного ритма. 
 
Interval/P2 – интервал/Ц2: бег на 3 км с темпом примерно 3,5-4 мин/км. 
 
Recovery/P3 – восстановление/Ц3: после 3-км бега дайте сердцу перейти на сердечный ритм 120 уд./мин. 
Повторите 2 и 3 циклы по 6 раз каждый. 
 
Cool down/P4 – заминка/Ц4: 10-мин бег с темпом примерно 5-6 мин/км. 
 
Дисплей во время упражнения 
 
Во время упражнения дисплей показывает: 
  

 

 
 
 

 
 
 
 
 

 
 
 
 
 
 

 
 

 
Каждый цикл начинается со следующей картинки дисплея: 
 
Название цикла 
 
Тип зоны 
 
Границы зоны 
 
Номер цикла повторяется слева 
 
Во время упражнения дисплей показывает: 
 
Обратный отсчет таймера/дистанции*, отсчет таймера вперед, номер текущего цикла. 
 
Целевую зону в графическом формате (обновляется каждые 10 сек, показывает картинку 
за последние 8 мин). 
 
Сердечный ритм 
 
Номер цикла повторяется слева 
 
В конце каждого цикла дисплей показывает: 
 
Продолжительность цикла или дистанцию* 
 
Разницу в сердечном ритме (насколько увеличили или уменьшили свой сердечный  ритм  
во время цикла). 
 
Средний сердечный ритм 
 
Число завершенных циклов 
 

 
После выполнения запрограммированного упражнения дисплей покажет, что оно 
завершено  
 
Беговой компьютер переходит в режим свободного упражнения, и вы можете продолжить 
тренировку уже без настроек. Упражнение записывается и информация собирается в 
файле, пока вы не прекратите упражнение. 
 

Подробнее о том, как планировать сеансы с помощью программного обеспечения  и передавать их потом на 
беговой компьютер см. в разделе о программном обеспечении. 
 
Функции во время упражнения 
 
Вы можете изменить настройки в запрограммированном упражнении так же, как в любом другом типе 
упражнений. Подробнее о различных функциях во время упражнения см. в разделе «Функции кнопок во время 
упражнения». 
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Запрограммированное упражнение использует настройки спортивного профиля в программном обеспечении. 
Если вы меняете настройки бегового компьютера во время упражнения (например, калибровочный 
коэффициент), изменения коснутся только текущего упражнения. В следующий раз, когда вы начнете делать 
то же самое упражнение, беговой компьютер будет использовать настройки спортивного профиля, которые 
определены в программном обеспечении. 
 
Меню кругов 
 
Для того чтобы увидеть меню кругов во время запрограммированного упражнения, нажмите и удерживайте 
ОК. Нажимая UP или DOWN, прокрутите меню кругов в зависимости от вашего упражнения. 
 
• End phase: закончить текущий цикл и перейти к следующему циклу упражнения 
• Jump to: перейти к любому другому циклу упражнения 
• Lock zon: или Unlock zone – «прикрепить» ваш сердечный ритм или скорость/темп* к определенной 

спортзоне, если упражнение не содержит заданных целевых зон. 
 
Для просмотра результатов упражнения выберите File > Exercise log. 
 
По завершении запрограммированного упражнения данные вашей тренировки будут сохранены как File.  
 
Подробнее см. в разделе «Анализ результатов упражнения». 
 
* Здесь требуется опциональный датчик s3 Stride Sensor W.I.N.D. 
 

9.  ТЕСТЫ 
 
Тест Polar Fitness Test™ 

 
Тест Polar Fitness Test™ – это простой, безопасный и быстрый способ измерить вашу готовность с точки 
зрения аэробного (сердечно-сосудистого) состояния в покое. Результат – Polar OwnIndex (собственный 
индекс Polar) – сопоставим с максимальным объемом вдыхаемого кислорода (VO2max), который обычно 
используется для оценки аэробной готовности. На собственный индекс влияют уровень физической 
активности в долгосрочном плане, сердечный ритм, изменение сердечного ритма в состоянии покоя, пол, 
возраст, рост и вес тела. Polar Fitness Test предназначен для использования здоровыми взрослыми людьми. 
 
Аэробная готовность показывает, насколько хорошо ваша  сердечно-сосудистая система работает с точки 
зрения подачи кислорода вашему телу. Чем лучше аэробная готовность, тем сильнее и эффективнее работа 
вашего сердца. Хорошая аэробная готовность приносит огромную пользу здоровью человека. Например, она 
помогает снижать ваше артериальное давление и риск сердечно-сосудистых заболеваний и инсульта. Если 
вы хотите улучшить свою аэробную готовность, то в среднем потребуется около 6 недель регулярных 
тренировок, чтобы добиться заметного прогресса в вашем собственном индексе. Менее здоровые люди 
увидят данный прогресс даже быстрее. Чем выше ваша аэробная готовность, тем меньшего прогресса стоит 
ждать в вашем собственном индексе.  
 
Аэробная готовность лучше всего поддается совершенствованию во время упражнений, в которых 
задействуются большие группы мышц. К таким упражнениям относится бег, езда на велосипеде, ходьба, 
гребля, плавание, катание на коньках и бег на лыжах. 
 
Для мониторинга прогресса начните измерять ваш собственный индекс по нескольку раз во время первых 
недель тренировок, чтобы получить линию отсчета, после чего повторяйте тест примерно раз в месяц. 
 
С помощью Polar Fitness Test можно также рассчитать предполагаемый максимальный сердечный ритм 
(HRmax-p). Этот показатель поможет определить макс. сердечный ритм более точно, чем по возрастной 
формуле (220 – возраст). Подробнее о HRmax см. в разделе «Настройки пользователя». 
 
Для того чтобы убедиться, что результаты теста достаточно достоверны, необходимо выполнить ряд базовых 
требований: 
 
• Тест можно выполнять где угодно – дома, в офисе,  в спортзале,– главное, чтобы атмосфера была 

спокойной. Не должно быть раздражающих звуков (например, телевизора, радио или телефона), а также 
находящихся рядом людей, которые пытаются в ступить с вами в разговор.  

• Проводите тест следует всегда в одной и той же обстановке и в одно и то же время. 
• За 2-3 часа до теста не есть тяжелой пищи и не курить. 
• В день теста и накануне избегать больших физических нагрузок и употребления лекарственных 

стимуляторов.  
• Расслабиться и успокоиться. Перед началом теста полежать в расслабленном состоянии 1-3 минуты. 
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Перед тестом 
 
Надевание передатчика 
 
Подробнее см. в разделе о начале тренировки. 
 
Ввод информации пользователя  
 
Выберите Settings > User (настройки > пользователь). 
 
Для выполнения Polar Fitness Test введите вашу персональную информацию пользователя и уровень 
долгосрочной физической активности в настройки User. 
 
Включение HRmax-p 
 
Если вы хотите получить предполагаемый максимальный сердечный ритм,  включите HRmax-p.  
 
Выберите Test > Fitness > HRmax-p > On (тест>фитнесс> HRmax-p > Вкл). 
 
Выполнение теста 
 
Выберите Test > Fitness > Start>  Fitness Test Lie Down (тест>фитнесс> пуск> выполнить тест). 
 
Polar Fitness Test начинается в течение 5 сек. Стрелки показывают, что тест уже идет. Лежите в 
расслабленном состоянии, избегая движений и разговоров с другими людьми. 
 
Если вы не установили в User Settings (настройки пользователя) уровень своей долгосрочной физической 
активности, на дисплее появится Set your physical activity level (команда на установление уровня). Выберите 
Top, High, Moderate или Low (элитный, высокий, средний или низкий). Подробнее см. в разделе «Настройки 
пользователя». 
 
Если в начале или в ходе выполнения теста беговой компьютер не получит ваш сердечный ритм, тест 
сорвется и на дисплее появится Test failed, check WearLink (тест сорвался, проверьте присоединение 
передатчика). Убедитесь, что электроды передатчика влажные, тканевый ремешок прилегает плотно, после 
чего повторите тест.  
 
Когда тест закончен, вы услышите 2 сигнала. На дисплее появится OwnIndex (собственный индекс) в 
цифровом выражении и оценка уровня. Подробнее см. в разделе «Классы уровня готовности». 
 
Для вывода на дисплей вашего предполагаемого максимального сердечного ритма нажмите DOWN. Для 
выхода нажмите ОК. 
Update to VO2 max? (скорректировать до макс. VO2?)  
 
• Выберите Yes для сохранения вашего собственного индекса в ваших настройках и меню Fitness Test 

Trend. 
• Выберите No, если вам известен измеренный лабораторно VO2max и если он отличается более чем на 

один класс от результата собственного индекса. Ваш собственный индекс сохраняется только в меню 
Fitness Test Trend. Подробнее см. в разделе «Тренд фитнес-теста». 

 
Update to HR max? (скорректировать до макс. сердечного ритма?)  
 
• Выберите Yes для сохранения данных в ваших настройках пользователя. 
• Выберите No, если вам известен измеренный лабораторно HR max. 
 
Проведение теста можно остановить в любое время нажатием на STOP. На несколько секунд на дисплее 
появится Fitness Test cancelled (фитнес-тест отменен).   
 

 После сохранения показателей собственного индекса и HRmax-p они будут использованы для расчета 
потребления калорий. 

 
После теста 
 
Классы фитнес-теста 
При оценке изменений в ваших личных показателях по прошествии времени самым значимым является ваш 
собственный индекс. Его можно также интерпретировать, исходя из пола и возраста. Установите, в какой 
части таблицы ниже находится ваш собственный индекс в таблице ниже, и сравните свою аэробную 
готовность с показателями других персон вашего пола и возраста. 
 
Собственный индекс атлетов-профессионалов колеблется вокруг 70 у мужчин и 60 у женщин. У олимпийских 
чемпионов собственный индекс может достигать 95. Наибольший показатель собственного индекса 
отмечается у спортсменов в тех видах, которые связаны с участием больших групп мышц, например, в беге и 
лыжных гонках.  
 
 
 



Фирменный магазин PolarSport.ru

Polar RS800 Руководство пользователя                 35 
 
 
 
Мужчины 
 
Возраст,       Очень Низкий  Ниже  Средний Хороший Очень  Элитный 
лет         низкий   среднего     хороший 
 
20-24             < 32 32-37  38-43  44-50  51-56  57-62  > 62 
 
25-29             < 31 31-35  36-42  43-48  49-53  54-59  > 59 
 
30-34             < 29 29-34  35-40  41-45  46-51  52-56  > 56 
 
35-39             < 28 28-32  33-38  39-43  44-48  49-54  > 54 
 
40-44             < 26 26-31  32-35  36-41  42-46  47-51  > 51 
 
45-49             < 25 25-29  30-34  35-39  40-43  44-48  > 48 
 
50-54             < 24 24-27  28-32  33-36  37-41  42-46  > 46 
 
55-59             < 22 22-26  27-30  31-34  35-39  40-43  > 43 
 
60-65             < 21 21-24  25-28  29-32  33-36  37-40  > 40 
 
 
Женщины 
 
Возраст,       Очень Низкий  Ниже  Средний Хороший Очень  Элитный 
лет         низкий   среднего     хороший 
 
20-24            < 27 27-31  32-36  37-41  42-46  47-51  > 51 
 
25-29            < 26 26-30  31-35  36-40  41-44  45-49  > 49 
 
30-34            < 24 25-29  30-33  34-37  38-42  43-46  > 46 
 
35-39            < 22 24-27  28-31  32-35  36-40  41-44  > 44 
 
40-44            < 22 22-25  26-29  30-33  34-37  38-41  > 41 
 
45-49            < 21 21-23  24-27  28-31  32-35  36-38  > 38 
 
50-54            < 19 19-22  23-25  26-29  30-32  33-36  > 36 
 
55-59            < 18 18-20  21-23  24-27  28-30  31-33  > 33 
 
60-65            < 16 16-18  19-21  22-24  25-27  28-30  > 30 
 
Классификация основана на данных 62 исследований, в которых VO2max был измерен у здоровых взрослых субъектов 
в США, Канаде и 7 странах Европы. См.: Е.Шварц, Р.С.Райболд «Нормы аэробной готовности для мужчин и женщин в 
возрасте от 6 до 75 лет. Обзор», изд-во Aviat Space Med, 1990г. 
 
Fitness Test Trend (тренд фитнес-теста) 
 
Выберите Test > Fitness > Trend.  
 
В меню Trend вы сможете увидеть, как прогрессирует ваш собственный индекс. Это изображение дисплея включает 
до 16 показателей собственного индекса с привязкой к датам. Когда этот файл оказывается заполненным, самый 
«старый» по времени результат удаляется. 
 
На дисплей выводятся самая последняя дата теста, график результатов вашего собственного индекса и самый 
последний показатель собственного индекса. Для просмотра других результатов используйте кнопки UP и DOWN. 
 
Удаление показателя собственного индекса 
 
Выберите Test > Fitness > Trend.  
 
Выберите показатель, который вы хотите удалить, нажмите и удерживайте LIGHT. На дисплее появится Delete value? 
No/Yes ( удалить показатель? нет/да).  
 
Выбор подтвердите ОК. 
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Анализ результатов собственного индекса с помощью программного обеспечения 
 
Загрузка результатов теста в программное обеспечение предоставляет возможность проведения их анализа 
различными путями, а также получения более подробной информации о вашем прогрессе. Программное 
обеспечение позволяет также провести графическое сравнение с предыдущими результатами. 
 

Polar OwnOptimizer™ (оптимизатор собственных результатов Polar) 
 

 
Общие положения 
 
Успешный процесс тренировки требует периодических перегрузок: более продолжительных упражнений, 
большей их интенсивности или общего объема. Во избежание перетренированности перегрузки должны 
всегда сопровождаться адекватными периодами восстановления. Без адекватных периодов восстановления 
в результате больших физических нагрузок вместо прогресса может произойти потеря физической формы. 
Polar OwnOptimizer - простой и надежный способ установить, способствует ли ваша программа тренировок 
оптимальному улучшению физической формы. Это устройство рассчитано на использование здоровыми 
взрослыми людьми. 
 
Polar OwnOptimizer - это модификация традиционного ортостатического теста на перетренированность. Он 
представляет собой приспособление, вставляемое в беговой компьютер для каждого, кто тренируется 
регулярно, не менее 3 раз в неделю, для улучшения готовности или достижения соревновательных целей. 
Данный параметр основывается на сердечном ритме и измерении изменчивости сердечного ритма, 
получаемых в ходе ортостатического теста (положение стоя после расслабляющего отдыха). OwnOptimizer 
помогает оптимизировать нагрузку во время тренировочной программы так, что вы ощущаете подъем 
физической формы и при этом не испытываете не перетренированности, ни недотренированности. Polar 
OwnOptimizer основан на регулярном измерении пяти параметров сердца в течение длительного времени. 
Два из них измеряются во время отдыха, один во время вставания и два в положении стоя. Всякий раз при 
прохождении теста датчик сохраняет данные сердечного ритма и сравнивает их с данными, полученными 
ранее.  
 
Перед тестом 
 
Базовые тесты 
 
Когда вы используете OwnOptimizer впервые, шесть базовых тестов должны быть проведены за две недели 
для установления ваших базовых характеристик.  Эти базовые измерения должны быть произведены в 
течение двух  типовых базовых недель, но ни в коем случае не в течение недель с большими 
тренировочными нагрузками. Базовые измерения должны включать тесты, снимаемые после тренировочных 
дней и после дней отдыха. 
 
Мониторинг показателей OwnOptimizer   
 
После записи базовых характеристик вы должны продолжить тестирование по 2-3 раза в неделю. Тестируйте 
себя еженедельно по утрам после дня восстановления и после дня больших тренировочных нагрузок (или 
нескольких подобных дней). В качестве варианта проведите третий тест после нормального тренировочного 
дня. OwnOptimizer может предоставить ненадежную информацию в период недотренированности или 
нерегулярных тренировок. Если вы сделаете перерыв в тренировочном процессе продолжительностью 14 
дней и больше, базовые тесты следует повторить. 
 
Выполнение теста 
 
Тест всегда должен проходить в стандартных условиях с тем, чтобы результаты были наиболее надежными. 
Тест рекомендуется проходить утром до завтрака. При этом выполняются следующие требования: 
 
• Наличие на теле передатчика. Подробнее см. в разделе «Начало тренировки». 
• Необходимо расслабиться и успокоиться. 
• Можно сидеть в расслабленной позе или лежать на кровати. При каждом выполнении теста поза должна 

быть одна и та же. 
• Тест можно выполнять где угодно – дома, в офисе,  в спортзале,– главное, чтобы атмосфера была 

спокойной. Не должно быть раздражающих звуков (например, телевизора, радио или телефона), а также 
находящихся рядом людей, которые пытаются в ступить с вами в разговор.  

• Не ешьте, не пейте и не курите за 2-3 часа до теста. 
 
Выполнение теста 
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Выберите Test >Optimizer > Start > Optimizer Lie Down. 
 
Стрелки указывают на то, что тест идет. В первой стадии теста продолжительностью 3 мин старайтесь не 
двигаться. 
 
Через 3 мин датчик подаст сигнал, и на дисплее появится Optimizer Stand up, после чего следует встать и 
оставаться в положении стоя еще 3 мин.   
 
Через 3 мин датчик снова подаст сигнал, что означает окончание теста. 
 
Результаты теста выводятся на дисплей в цифровом и письменном формате. Нажмите DOWN, чтобы увидеть 
свой средний сердечный ритм (уд./мин) в положении лежа (HRrest), самый высокий сердечный ритм в 
положении стоя (HRpeak) и средний сердечный ритм в положении стоя (HRstand). 
 
Прервать тест в любой момент можно нажатием на STOP. При этом на экране появится Optimizer Test 
canceled (тест отменен).  
 
Если беговой компьютер не получит ваш сердечный ритм, тест сорвется и на дисплее появится Test failed, 
check WearLink (тест сорвался, проверьте присоединение передатчика). Убедитесь, что электроды 
передатчика влажные, а тканевый ремешок прилегает плотно. 
 

После теста 
 
Как толковать результаты 
 
Датчик рассчитывает 5 сердечных ритмов и изменчивость сердечного ритма на основе параметров. Данные 
OwnOptimizer рассчитываются путем сравнения ваших последних показателей с предыдущими. Датчик 
выводит на дисплей письменное описание вашего тренировочного состояния, что подробно представлено 
ниже.   
 
Good recovery (1) (хорошее восстановление) 
Ваш сердечный ритм ниже среднего, что означает, что вы восстановились очень хорошо. Вы можете 
продолжать тренировки, включая сеансы интенсивных нагрузок. 
 
Normal State (2) (нормальное состояние) 
Ваш сердечный ритм на нормальном уровне. Продолжайте тренировки, включая сеансы и легких, и 
интенсивных нагрузок, сочетая их с восстановлением.  
 
Training Effect (3) (эффект тренировок) 
Ваш сердечный ритм выше среднего. Возможно, в предыдущие дни вы интенсивно тренировались. У вас 2 
варианта: 1) отдохнуть или проводить легкие тренировки 1-2 дня; 2) продолжать интенсивные тренировки 1-2 
дня, после чего как следует восстановиться. Причиной подобного результата может также быть стресс, 
отмечаемый в начале  ОРВИ или гриппа.  
 
Steady State (4) (устойчивое состояние) 
Ваш сердечный ритм показывает нормальный уровень в течение длительного времени. Эффективная 
тренировка требует как интенсивных упражнений, так и хорошего восстановления, что должно сказываться на 
изменчивости ваших результатов сердечного ритма. Ваши результаты  OwnOptimizer указывают, что у вас 
какое-то время не было интенсивных тренировок или хорошего восстановления. Повторите тест после дня 
отдыха или дня легкой тренировки. Если отдых был эффективным, ваш результат должен показать Good 
recovery (хорошее восстановление).  
 
Stagnant State (5) (вялое состояние) 
Ваш сердечный ритм на нормальном уровне, и это продолжается уже долго. Результаты указывают, что ваши 
тренировки были недостаточно интенсивны, чтобы получить оптимальное повышение тонуса. Для того чтобы 
эффективно улучшить свое состояние, вам необходимо включить в программу сеансы более интенсивных 
или более продолжительных упражнений. 
 
Hard Training (6) (тяжелые тренировки) 
Ваш сердечный ритм несколько раз превысил средний уровень. Возможно, вы намеренно сильно 
тренировались. Результат показывает перетренированность, поэтому вам необходимо как следует 
восстановиться. Для мониторинга восстановления повторите тест после 1-2 дней отдыха или легких 
тренировок. 
 
Overreaching (7 ) (перетренировка) 
Ваши результаты  OwnOptimizer указывают, что у вас в течение нескольких дней, а то и недель шли 
интенсивные тренировки. Ваш сердечный ритм постоянно остается на высоком уровне. Это очень серьезный 
симптом - вам остро необходим период полного восстановления. Чем продолжительнее был период 
интенсивных тренировок, тем продолжительнее требуется период восстановления. Проведите повторный 
тест не менее чем через 2 дня после восстановления. 
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Sympathetic Overtraining (8) (симпатическая перетренированность)  
Ваши результаты  OwnOptimizer указывают, что у вас в течение нескольких дней, а то и недель шли 
интенсивные тренировки, а восстановление при этом было недостаточным. Это привело к состоянию 
перенапряжения. Для возвращения в нормальное состояние для тренировок отдохните в течение периода 
восстановления, подвергаясь при этом тщательному мониторингу. Вслед за восстановлением проводите тест 
OwnOptimizer по 2-3 раза в неделю. 
 
Parasympathetic Overtraining (9) (парасимпатическая перетренированность)  
Ваш сердечный ритм «застыл» на низком уровне, что, вроде бы, расценивается как знак хорошего 
восстановления. Однако другие параметры указывают на парасимпатическую перетренированность. 
Возможно, вы много тренировались в течение долгого времени, а восстановление при этом было 
недостаточным. Проверьте наличие других симптомов перетренированности: низкой физической формы, 
усилившейся усталости, наличия проблем со сном, постоянных болезненных ощущений в мышцах и/или 
ощущения, что вы «испеклись» и выдохлись. Могут наблюдаться и другие стрессы. 
 
В целом развитие парасимпатической перетренированности бывает результатом очень длительных и очень 
интенсивных тренировок. Чтобы выйти из этого состояния, вам необходимо полностью восстановить баланс 
тела. Здесь можно предложить несколько дней легкой аэробики и только коротких и редких сеансов 
интенсивных упражнений.  
 
Можно также попробовать что-то отличное от вашего основного вида тренировок. Но новый вид должен быть 
хорошо знакомым и не приносить никаких неудобств. Проведите мониторинг своего восстановления, 
подвергнув себя тесту OwnOptimizer по 2-3 раза в неделю. Как только почувствуете, что баланс тела 
восстановился, а результаты будут отвечать состоянию Normal State или Good recovery (причем лучше всего, 
если это будет наблюдаться неоднократно), можно рассмотреть вопрос о возобновлении тренировок. Как 
только они возобновятся, начните новый период тестирования с проведения новых базовых измерений.  
 

 Прежде чем радикально менять свою тренировочную программу, оцените результаты OwnOptimizer и 
сопоставьте их со своими субъективными ощущениями или любыми симптомами. Если вы не уверены в 
том, что ваше состояние пришло в норму, повторите тест OwnOptimizer. На отдельные результаты 
теста могут оказать влияние различные внешние факторы, такие как психический стресс, скрытое 
заболевание, изменение условий окружающей среды (температуры, высоты над уровнем моря) и др. 
Ваши расчеты базовых показателей должны обновляться не реже 1 раза в год перед началом нового 
сезона тренировок. 

 
OwnOptimizer Trend (тренд OwnOptimizer) 
 
Выберите Test > Optimizer > Trend и посмотрите, как прогрессируют ваши данные OwnOptimizer в меню 
Trend. Оно включает 16 последних ваших данных OwnOptimizer и даты их записи. По переполнению файла 
тренда последние данные автоматически заменяют самые старые по давности регистрации. 
 
На дисплей выводятся данные последнего теста, графическое изображение изменения ваших результатов и 
последние из них. Для прочтения письменного описания результата нажмите ОК. Для просмотра остальных 
данных используйте кнопки UP и DOWN.  
 
Удаление данных OwnOptimizer 
 
Выберите Test > Optimizer > Reset (сброс). Вы можете сбросить тестовый период OwnOptimizer. Все 
результаты тестов будут удалены из памяти. При выполнении теста после 365-дневного тестового периода 
или после 30-дневного перерыва на дисплее появляется Reset test period? (сбросить тестовый период?). 
 
Анализ результатов с помощью программного обеспечения 
 
Загрузка тестовых результатов в программное обеспечение предоставляет вам возможность провести их 
анализ различными способами, а также получить доступ к более подробной информации о вашем прогрессе. 
Программное обеспечение также предоставляет возможность графического сравнения с предыдущими 
результатами.  
 
 
10.  ИСПОЛЬЗОВАНИЕ НОВЫХ ПРИНАДЛЕЖНОСТЕЙ 
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Обучение 
 
Ваш беговой компьютер «обучен» работе совместно с передатчиком Polar WearLink W.I.N.D. и датчиком шага 
s3 для измерения данных сердечного ритма,  скорости/темпа и дистанции. Другими словами, ваш беговой 
компьютер получает сигналы только от вашего передатчика и датчика шага и позволяет выполнять 
упражнения в группе, никому при этом  не мешая. 
 
Если вы приобретаете новый передатчик или датчик шага, их необходимо ввести в беговой компьютер. Этот 
процесс называется «обучением» и занимает несколько секунд.  
 

 Перед участием в групповых соревнованиях убедитесь, что дома вы уже проделали обучение. Это 
необходимо для предотвращения помех из-за длительности процесса передачи данных. 

 
Обучение нового передатчика 
 
В режиме времени нажмите OK > New WearLink found, Teach new Wearlink? (новый WearLink найден, 
обучить его?). 
 
Наденьте передатчик и убедитесь, что ближе 20 м от него нет другого передатчика Polar WearLink W.I.N.D. В 
этом режиме нажмите ОК. Беговой компьютер начнет поиск сигнала передатчика. 
 
Как только передатчик идентифицирован, на дисплее появляется New WearLink found, Teach new Wearlink? 
 
• Выберите Yes для подтверждения обучения. На дисплее появляется Completed! (завершено). Начните 

запись упражнения нажатием на ОК.  
• Выберите No для отмены обучения. 
 
Обучение датчика шага 
 
Выберите Settings > Features > S sensor > New sensor (новый датчик). 
 
Убедитесь, что ближе 20 м от датчика шага нет другого такого же. Датчик должен быть на расстоянии не 
более 1,5 м от бегового компьютера. 
 
На дисплее появляется Teach new sensor? (обучить новый датчик?). 
 
• Выберите Yes для подтверждения обучения. На дисплее появляется Completed! (завершено).  
• Выберите No для отмены обучения. Беговой компьютер будет неспособен измерять скорость/темп и 

дистанцию. 
 
В памяти бегового компьютера можно хранить до 4 датчиков. При превышении этого количества первый из 
занесенных в память датчиков заменяется. 
 
 
11.  ДОПОЛНИТЕЛЬНАЯ ИНФОРМАЦИЯ  
 

Спортивные зоны Polar  
 
Спортивные зоны Polar представляют собой новый уровень эффективности тренировки, основанной на 
сердечном ритме. Сам процесс тренировки разбит на 5 спортзон, основанных на проценте макс. сердечного 
ритма. С помощью спортзон вы можете легко выбирать и вести мониторинг интенсивности тренировки. 
 
Целевая зона  % макс.   Примерная   Преимущества 
   сердечного ритма, продолжительность, 
   уд./мин   мин 
МАКСИМУМ  900-100%,  менее 5   Выгоды: макс. или почти макс.  
   171-190      усилия для дыхания и мышц. 
          
         Ощущения: очень утомительное  
         для дыхания и мышц. 
 
         Рекомендуется для: очень опытн- 
         ых и подготовленных бегунов.  
         Только короткие интервалы,  
         обычно на последней стадии под- 
         готовки к соревнованиям по бегу  
         на короткие дистанции.  
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Целевая зона  % макс.   Примерная   Преимущества 
   сердечного ритма, продолжительность, 
   уд./мин   мин 
ТРУДНАЯ  80-90%,   2-10   Выгоды: увеличивает способность  
   152-172      выдерживать высокосортные  
         нагрузки.  
          
         Ощущения: вызывает  
         мускульную усталость и тяжелое  
         дыхание. 
 

         Рекомендуется для: опытных бегу- 
         нов для круглогодичных трениро- 
         вок с варьированием длины.  
         Становится более важной в   
         предсоревновательный период. 
СРЕДНЯЯ  70-80%,   10-40   Выгоды: улучшает общий трениро- 
   133-152      вочный темп, облегчает усилия  
         средней интенсивности и улучшает  
         эффективность. 
 

         Ощущения: стабильно контролиру- 
         емое учащенное дыхание. 
 

         Рекомендуется для: бегунов, про-
         грессирующих к соревнованиям и 
         желающим улучшить физическую 
         форму, особенно для тренировки 
         полумарафона и марафона.  
ЛЕГКАЯ  60-70%,   40-80   Выгоды: улучшает общую базовую  
   114-133      готовность, улучшает восстановле- 
         ние и помогает ускорить метабо- 
         лизм. 
 

         Ощущения: комфортности и прос- 
         тоты выполнения, низкая мышеч- 
         ная и сердечно-сосудистая нагруз- 
         ка.  
 

         Рекомендуется для: всех на весь 
         тренировочный сезон во время ба-
         зовых тренировочных периодов и 
         для восстановительных упражне- 
         ний в соревновательном цикле. 
ОЧЕНЬ   50-60%,   20-40   Выгоды: помогает размяться и ус- 
ЛЕГКАЯ  101-114      покоиться и способствует восста- 
         новлению. 
 

         Ощущения: простота и малые  
         нагрузки. 
 

         Рекомендуется для: упражнений и  
         восстановление и упокоение в те- 
         чение всего тренировочного  
         сезона. 
 

HRmax = макс. сердечный ритм (220 - возраст). Пример: возраст 30 лет, 220 - 30 = 190 уд./мин. 
Бег в спортзоне 1 ведется с очень маленькой интенсивностью. Основной принцип тренировки состоит в том, 
что ваша физическая форма улучшается во время восстановления после тренировки, а не только вовремя 
самой тренировки. Вы можете ускорить процесс восстановления, проведя тренировку с очень маленькой 
интенсивностью.  
 

Спортзона 2 - для тренировки выносливости. Это существенная часть тренировочной программы. Сеансы 
бега в этой зоне очень просты и аэробны. Продолжительные тренировки в этой зоне способствуют большому 
расходу энергии. Прогресс здесь потребует проявления упорства.  
Аэробная сила увеличивается в спортзоне 3. Интенсивность тренировочного процесса повыше, чем в 
спортзонах 1 и 2, но она по-прежнему аэробна. Тренировочный процесс в спортзоне 3 может, например, 
состоять из интервалов, за которыми следует восстановление. Бег в этой зоне особенно эффективен для 
улучшения циркуляции крови в сердце и костных мышцах.  
 

Если ваша цель достичь потолка своего потенциала, вам следует тренироваться в спортзонах 4 и 5. В этих 
зонах вы бежите анаэробно, в интервалах продолжительностью до 10 мин. Чем короче интервал, тем выше 
интенсивность. Большое значение имеет полноценное восстановление между интервалами. Тренировочная 
модель спортзон 4 и 5 разработана для достижения максимальной физической формы. 
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Спортзоны Polar можно персонифицировать, используя для этого установленный лабораторно ваш макс. сердечный 
ритм или этот показатель, измеренный в ходе отдельного теста. Ведя бег в спортзоне, старайтесь использовать всю 
зону по максимуму. Середина зоны - это хорошая цель, но в поддержании вашего сердечного ритма на этом конкретном 
уровне в течение всего времени нет необходимости.  Сердечный ритм постепенно приспосабливается к интенсивности 
тренировки. Например, при переходе от спортзоны 1 к спортзоне 3 система циркуляции и сердечного ритма входят в 
норму в течение 3-5 минут. 
 
Сердечный ритм реагирует на интенсивность упражнения в зависимости от таких факторов как готовность и уровень 
восстановления, а также от факторов среды. Важно прислушиваться к субъективным ощущениям усталости и 
соответственно корректировать программу тренировок. 
 
Простейший вариант использования спортзон - установление собственных целевых зон сердечного ритма. Инструкции 
см. в разделе «Планирование тренировочного процесса».  
 
По завершении упражнения его продолжительность выводится на дисплей в спортзонах. Войдите в дисплей Weekly 
(недельный), чтобы посмотреть, в каких зонах вы тренировались и сколько времени провели в каждой из зон. 
 
Polar ProTrainer5 предлагает до 10 спортзон, чтобы как можно лучше удовлетворить ваши потребности в части 
тренировки и получения сведений о резерве вашего сердечного ритма. 
 

OwnZone Training (тренировка в собственной зоне) 
Ваш беговой компьютер автоматически определяет индивидуальную и безопасную с точки зрения интенсивности зону 
упражнений - вашу OwnZone. Уникальная Polar OwnZone определяет вашу персональную тренировочную зону для 
аэробной тренировки. Ее функции инструктируют вас, как разминаться, и принимают во внимание ваше текущее 
физическое и моральное состояние. Для большинства взрослых людей OwnZone соответствует 65-85% макс. 
сердечного ритма. 
 
OwnZone можно определить в течение 1-5 минут во время разминки, когда вы идете, бежите трусцой или выполняете 
иные физические упражнения. Идея состоит в том, чтобы начать упражнение медленно с низкой интенсивностью, 
постепенно ее увеличивая вместе с сердечным ритмом. OwnZone была разработана для ее использования здоровыми 
людьми. Некоторые причины могут не позволить определить  OwnZone на основе вариативности сердечного ритма. К 
ним относится наличие высокого кровяного давления, аритмии сердца и прием некоторых препаратов. 
 
Важной составной частью достижения высокой физической готовности является необходимость прислушиваться к 
сигналам, которые ваше тело посылает во время физических усилий, и их интерпретация. Поскольку разминка перед 
различными упражнениями имеет свою специфику и ваше моральное и физическое состояние также разнится день ото 
дня (по причине стресса или болезни), использование функции OwnZone для каждого сеанса тренировок гарантирует 
наиболее эффективную целевую зону сердечного ритма для каждого конкретного вида упражнений и каждого 
конкретного дня. 
 

Максимальный сердечный ритм 
Макс. сердечный ритм (HRmax) - это максимальное число уд./мин при максимальном физическом напряжении. Он 
индивидуален и зависит от возраста, наследственных факторов и уровня готовности. Он может также меняться при 
занятии различными видами спорта. Показатель HRmax используется для выражения интенсивности упражнения. 
 
Определение макс. сердечного ритма 
Ваш макс. сердечный ритм можно определить разными способами: 
 
• Самый точный - измерить его в клинике. Обычно для этого применяется бегущая доска или велотренажер. Тест 

проводится кардиологом или физиотерапевтом. 
• Можно измерить макс. сердечный ритм в ходе отдельного теста, проводимого вместе с партнером по тренировкам. 
• Можно получить показатель вашего HRmax -р, который прогнозирует ваш макс. сердечный ритм путем выполнения 

Polar Fitness Test. 
• Показатель макс. сердечного ритма можно также рассчитать, пользуясь обычной формулой 220 - возраст, однако 

опыт показывает, что данный метод не очень точен, особенно для пожилых людей и тех, кто поддерживал на 
высоком уровне свою готовность в течение многих лет. 

 
Если за последние недели вы выполняли тяжелые упражнения и знаете, что можете без труда достичь свой макс. 
сердечный ритм, можно спокойно проводить тест на определение макс. сердечного ритма самостоятельно. Во время 
теста рекомендуется иметь рядом тренированного товарища. Если у вас есть сомнения, проконсультируйтесь ос своим 
терапевтом. 
Ниже приведен пример простого теста. 
 
Шаг 1: разомнитесь в течение 15 мин на ровной поверхности, подготовя себя для обычного тренировочного темпа. 
Шаг 2: выберите возвышенность или лестницу, подъем на которые занимает более 2 мин. Совершите подъем бегом в 
максимальном темпе, который вы можете поддерживать в течение 20 мин. Вернитесь к основанию 
возвышенности/лестницы. 
Шаг 3: совершите повторный подъем в максимальном темпе, который вы можете поддерживать в течение 3 км. 
Отметься свой самый высокий сердечный ритм. Ваш макс. сердечный ритм примерно на 10 уд./мин больше, чем 
полученный показатель. 
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Шаг 4: сбежите вниз к основанию возвышенности, позволив сердечному ритму уменьшится на 30-40 уд./мин. 
Шаг 5: совершите еще один подъем в максимальном темпе, который вы можете поддерживать в течение 1 
мин. Старайтесь при этом добежать до середины возвышенности/лестницы. Отметься свой самый высокий 
сердечный ритм. Это приблизит вас к вашему макс. сердечному ритму. Используйте полученный показатель 
среднего сердечного ритма для установки зон тренировки. 
Шаг 6: убедитесь, что для полного успокоения вам потребовалось не более 10 мин. 
 

Показатель сердечного ритма в положении сидя (HRsit) 
 
HRsit - это ваш средний сердечный ритм в состоянии полного покоя (например, в сидячем положении). Для 
определения этого показателя наденьте передатчик, сядьте и не осуществляйте никаких движений. Для того 
чтобы получить более точную цифру, повторите тест несколько раз и выведите среднюю величину. 
 

Резерв сердечного ритма 
 
Резерв сердечного ритма – это разница между максимальным сердечным ритмом (HRmax) и сердечным 
ритмом в состоянии покоя (HRrest).*  Резерв сердечного ритма используется для расчета сердечного ритма 
упражнений. Он представляет собой амплитуду, в рамках которой происходит колебание сердечного ритма в 
зависимости от уровня напряжения. Показатель резерва сердечного ритма равняется резерву максимально 
вдыхаемого объема кислорода (VO2R).  
 
Сердечный ритм упражнения можно определить, используя формулу Карвонена**. Добавьте данный процент 
резерва сердечного ритма к сердечному ритму в состоянии отдыха.  
Сердечный ритм упражнения = % целевой интенсивности (HRmax - HRrest ) + HRrest. 
 
Пример: 
 
Целевая интенсивность 70% для человека с HRmax 201 уд./мин и HRrest 50 уд./мин. 
 
Сердечный ритм упражнения = 70% (201-50) + 50. 
 
Сердечный ритм упражнения = 156 уд./мин. 
 
Для установления точного сердечного ритма вам нужны точные показатели HRmax и HRrest . При 
использовании примерного HRmax и показатель сердечного ритма упражнения будет примерным. 
 
* В беговых компьютерах Polar RS400 и RS800 сердечный ритм в состоянии покоя измеряется как этот 
же показатель в состоянии сидя. Именно в силу практического подхода показатель HRsit  используется 
для подсчета расхода энергии, как более точный. Указанный показатель соответствует режиму  низкой 
интенсивности, с которым можно сравнивать большинство видов упражнений. 
 
** К.Карвонен, К.Кентала, О.Мустала «Эффект тренировки сердечного ритма. Изучения явления в разные 
моменты времени». 1957г., стр. 307-315. 
 

Изменчивость сердечного ритма 
 
Сердечный ритм меняется с каждым ударом сердца. Изменчивость сердечного ритма – это колебание 
интервала от удара до удара, известного под названием R-R интервала.  
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Изменчивость сердечного ритма указывает на колебания сердечного ритма вокруг его среднего показателя. 
Сердечный ритм в 60 ударов в минуту отнюдь не означает, что удар происходит каждую секунду. Наоборот, 
интервал может составлять от 0,5 до 2,0 сек. 
 
На изменчивость сердечного ритма влияет аэробная готовность. Ритм у хорошо тренированного сердца в состоянии 
отдыха обычно бывает большим. Из других факторов, влияющих на изменчивость сердечного ритма, следует 
отметить возраст, генетические факторы, время суток и состояние здоровья. Во время упражнения изменчивость 
сердечного ритма падает, а интенсивность упражнения растет. Изменчивость сердечного ритма также уменьшается 
в периоды психических стрессов. 
 
Изменчивость сердечного ритма регулируется автономной нервной системой. Парасимпатическая активность 
уменьшает сердечный ритм и увеличивает его изменчивость, в то время как симпатическая активность производит 
обратное воздействие.  
 
Изменчивость сердечного ритма используется в параметрах Ownzone, OwnIndex и OwnOptimizer. Мониторинг 
изменчивости сердечного ритма можно также вести с помощью бегового компьютера. Если ваш показатель 
изменчивости сердечного ритма меняется при данном темпе и сердечном ритме, это может указывать на изменение 
нагрузки вашей тренировки и наличие стресса. 
 

Частота шагов и длина шага 
 
Частота шагов* - это количество раз, которое нога с датчиком шага* касается земли в минуту.  
Длина шага* - это средняя длина одного вашего шага, т.е. расстояние между левой и правой ногами, касающимися 
земли. 
 
Скорость бега = 2 * длину шага * частота шагов. 
 
Есть два способа увеличить скорость бега: чаще перебирать ногами или увеличить длину шага.  
 
Профессиональные бегуны на длинные дистанции обычно бегут с высокой частотой шага– 85-95. На подъемах ритм 
снижается, на спусках растет. Для того чтобы набрать скорость, бегуны регулируют ритм бега – по мере увеличения 
скорости растет длина шага. 
 
Наиболее распространенная ошибка новичков – слишком длинный шаг при беге. Оптимальной является 
естественная длина шага, т.е. наиболее комфортная для человека. Вы будете бежать быстрее за счет напряжения 
мышц ног, которые будут нести вас вперед с более длинным шагом.  
 
Вы должны также работать над максимизацией эффективности частоты шагов. Добиться прогресса в частоте 
непросто, но если правильно тренироваться, можно научиться поддерживать частоту в течение всего бега и 
максимизировать, таким образом, свою физическую готовность. Для начала хорошо проводить еженедельные 
тренировки частоты. Включите небольшую работу над частототой и в остальные тренировки недели. Во время 
продолжительных забегов можно время от времени практиковать увеличенную частоту шагов.  
 
Во время тренировки более длинных дистанций (полумарафона,  марафона и больше) полезно вести мониторинг 
частоты шагов. Низкая частота при ожидаемом темпе бега может создать проблемы на дистанции позднее, когда 
ноги начнут уставать. Один из способов избежать этого – работать над увеличением скорости ног при ожидаемом 
темпе бега. Вы можете установить беговой компьютер на демонстрацию темпа и частоты. Поддерживая тот же ритм 
бега, попробуйте уменьшить длину шага и увеличить частоту шагов (установите зону более короткого шага, чтобы 
получать обратный звуковой сигнал). Вы можете поставить цель поднять ритм бега сверх следующих показателей: 
 

• 80/мин (для пробегающих марафон за 4 часа) 
• 85/мин (для пробегающих марафон за 3,5 часа) 
• 88/мин (для пробегающих марафон за 3 часа) 
 

Это только общие ориентиры, ведь у более высоких бегунов будет, естественно, более низкий ритм. Бегуны также 
должны обязательно ориентироваться на свое собственное состояние.  
 
Хороший способ улучшить длину шага – предпринять специальные силовые упражнения типа бега вверх по холму, 
бега по мягкому песку, бега с увеличением длины шага. 6-недельные тренировки, включающие силовые 
упражнения, должны привести к заметному прогрессу в длине шага, что в сочетании с увеличившейся скоростью 
работы ног (такой, как, например, короткий шаг при лучшем темпе бега на 5 км) приведет к заметному улучшению 
общей скорости также. 
 
* Здесь требуется опциональный датчик s3 Stride Sensor W.I.N.D. 

 

Запись R-R интервалов 
 

Запись R-R интервалов позволяет сохранять интервалы между ударами сердца. Эта информация демонстрируется 
также как мгновенный сердечный ритм в уд./мин.  
При записи каждого отдельного интервала можно также видеть экстрасистолы и ложные изображения. Для 
оптимизации контакта между кожей и передатчиком мы рекомендуем использовать контактный гель (например, 
ECG). Показатели, понимаемые как неправильные в части сердечного ритма, можно откорректировать 
программным обеспечением. 
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Polar Running Index (коэффициент бега Polar) 
 
Коэффициент бега - легкодоступный способ контроля изменения физической формы. На физическую форму 
(т.е. на то, как быстро/легко вы бежите в заданном темпе) оказывает прямое воздействие аэробная 
готовность (VO2max) и экономность упражнения (т.е. то, насколько ваше тело эффективно при беге), а 
коэффициент бега - измеритель этого воздействия. Записывая ваш коэффициент бега на протяжении 
длительного времени, вы можете контролировать свой прогресс. Улучшение означает, что вам требуется 
меньше усилий, чтобы бежать в заданном темпе, или что ваш темп стал выше при заданном уровне 
напряжения. Коэффициент бега показывает в цифрах указанное улучшение. Он предоставляет вам также 
ежедневную информацию об уровне вашей беговой формы, которая может меняться день ото дня. 
 
Выгоды коэффициент бега: 
 
• подчеркивает положительный эффект от хороших тренировок и дней отдыха. 
• контролирует развитие готовности и физической формы при различных уровнях сердечного ритма, а не 

только при максимальной физической форме. 
• дает возможность определить вашу оптимальную скорость бега путем сопоставления беговых 

коэффициентов при различных видах тренировок. 
• подчеркивает прогресс за счет лучшей техники бега и уровня готовности. 
 
Коэффициент бега рассчитывается во время каждого упражнения, когда ваш сердечный ритм и сигнал 
датчика шага записываются  и когда соблюдаются следующие требования: 
 
• скорость - 6 км/час или выше в течение не менее 12 мин бега. 
• сердечный ритм - выше 40% макс. сердечного ритма. 
 
Убедитесь, что ваш датчик шага откалиброван. Расчет начинается, когда вы начинает запись сеанса. Во 
время сеанса вы можете остановиться, например, у светофора, не прерывая при этом расчет. 
 
В конце на дисплее вашего бегового компьютера появляется величина коэффициента бега, которая 
сохраняется в разделе файла. Сравните ваши данные с данными таблицы ниже. Используя программное 
обеспечение, можно контролировать и анализировать прогресс в величине коэффициента бега по времени и 
в разрезе различных скоростей бега. Или сравнивать данные из различных сеансов упражнений и 
анализировать их в краткосрочном и долгосрочном периодах. 
 
Краткосрочный анализ 
 
Коэффициент бега    Уровень физической формы  
 
< 30      Очень низкая 
 
31-37      Низкая 
 
38-44      Ниже среднего 
 
45-51      Средняя 
 
52-58      Хорошая 
 
59-65      Очень хорошая 
 
> 65      Отличная 
 
 
В течение дня могут быть вариации коэффициента бега, определяемые условиями бега: по ровной 
поверхности, по холмистой поверхности, сила ветра, температура. 
 
Долгосрочный анализ 
 
Показатели одного коэффициента бега формируют тенденцию, которая прогнозирует ваш успех в 
преодолении определенных дистанций. 
 
В таблице ниже приведены временные показатели, в которые бегун может укладываться при максимальной 
физической форме. Для интерпретации данных таблицы используйте ваш средний долгосрочный 
коэффициент бега.  
Прогнозирование является наиболее точным для тех коэффициентов бега, которые получены при 
скоростях и условиях бега, аналогичных целевым. 
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Коэффициент   Тест Купера,          5 км        10 км      21.098 м     42.195 м 
бега   м.  (час:мин:сек) (час:мин:сек) (час:мин:сек) (час:мин:сек) 
 
36   1900  0:37:30  1:16:00  2:45:00  5:45:00 
 
38   2000  0:35:0  1:11:30  2:34:00  5:20:00 
 
40   2100  0:32:30  1:06:30  2:24:00  5:00:00 
 
42   2200  0:30:45  1:03:00  2:16:00  4:45:00 
 
44   2300  0:29:00  0:59:30  2:09:00  4:30:00 
 
46   2400  0:28:00  0:57:30  2:04:00  4:20:00 
 
48   2500  0:26:45  0:55:00  1:59:00  4:10:00 
 
50   2600  0:25:30  0:52:30  1:54:00  4:00:00 
 
52   2700  0:24:15  0:50:00  1:49:00  3:50:00 
 
54   2850  0:23:15  0:48:00  1:44:00  3:40:00 
 
56   2950  0:22:15  0:46:00  1:40:00  3:32:00 
 
58   3100  0:21:15  0:44:00  1:36:00  3:25:00 
 
60   3200  0:20:30  0:42:30  1:33:00  3:18:00 
 
62   3300  0:19:30  0:40:30  1:29:00  3:10:00 
 
64   3400  0:19:00  0:39:30  1:26:00  3:05:00 
 
66   3500  0:18:30  0:38:30  1:24:00  3:00:00 
 
68   3650  0:17:45  0:37:00  1:21:00  2:55:00 
 
70   3750  0:17:15  0:36:00  1:19:00  2:50:00 
 
72   3900  0:16:30  0:34:30  1:16:00  3:45:00 
 
74   4000  0:16:00  0:33:30  1:14:00  2:40:00 
 
76   4100  0:15:30  0:32:30  1:12:00  2:35:00 
 
78   4200  0:15:15  0:32:00  1:10:00  2:30:00 
 
* Здесь требуется опциональный датчик s3 Stride Sensor W.I.N.D. 
 
Следует помнить, что кроме хорошего коэффициента бега, максимальная беговая форма требует хорошей 
подготовки, оптимальных условий бега, скоростной выносливости и выдержки. Качество и количество 
тренировок имеют такое же значение, как и природный талант. 
 
Библиотечка Polar 
 
Подробнее о том, как усовершенствовать ваш бег, можно узнать, посетив сайт http://articles.polar.fi  
 
 
12.  ИНФОРМАЦИЯ ПО ОБСЛУЖИВАНИЮ 
 
Уход и техническое обслуживание 
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Уход за вашим прибором 
 
Как и любой электронный прибор, беговой компьютер Polar нуждается в аккуратном обращении. Помещенные 
ниже советы помогут вам обеспечить выполнения гарантийных обязательств и получать удовольствие от 
вашего прибора в течение многих лет. 
 
После использования вынимайте разъем передатчика из ремешка. Промойте разъем слабым мыльным 
раствором. Протрите его тряпкой. Не используйте спиртосодержащих жидкостей или абразивных материалов 
(стальную вату или чистящие вещества). 
 
После каждого использования промывайте ремешок передатчика водой. Если вы используете ремешок 
чаще трех раз в неделю, стирайте его не реже раза в три недели в стиральной машине при температуре 
40°С. Используйте мешочек для стирки. Не замачивайте и не используйте стиральные порошки с 
отбеливателем и кондиционеры для ткани. Не подвергайте ремешок химчистке или отбеливанию. 
 
Стирайте ремешок перед длительным его хранением и всякий раз после использования в воде бассейна, 
богатой хлоркой. Не подвергайте ремешок барабанной сушке и не гладьте его. Не кладите ремешок в 
стиральную машину с другим бельем или в сушильный агрегат! Сушите и храните ремешок и разъем 
отдельно. 
 
Храните беговой компьютер, передатчик, датчик foot pod и датчик шага в сухом прохладном месте. Не 
храните их во влажной среде и не дышащих материалах (пластиковых мешках или спортивных сумках), а 
также рядом с проводящими материалами (мокрым полотенцем). Не опускайте Датчик в воду. Не подвергайте 
его воздействию прямого солнечного света в течение длительного времени. 
 

Рабочая температура - от -10 °С до +50 °С. 
 
Обслуживание 
 
В течение 2-летнего гарантийного периода мы рекомендуем обслуживать ваш прибор только в 
авторизованных сервисных центрах Polar. Гарантия не распространяется на повреждения или косвенные 
убытки, причиненные во время обслуживания вне авторизованных сервисных центров Polar Electro. 
Подробнее см. в разделе «Ограниченная международная гарантия Polar». 
 
Замена батареек 
 
Для самостоятельной замены батареек в беговом компьютере, передатчике или датчике шага* строго 
следуйте инструкциям в разделе «Установка батарейки в датчике шага». Все батарейки меняются одинаково. 
 
Если вы хотите, чтобы замену батареек произвела компания Polar, свяжитесь с ее сервисным центром. В 
этом случае после замены батареек вам протестируют датчик.           
 
Интенсивное использование подсветки ведет к ускоренному расходованию заряда батарейки. При низких 
температурах может появиться индикатор низкого заряда батарейки, который исчезает при переходе в среду 
с большей температурой. Для максимального продления срока службы крышки батарейного отсека 
открывайте только при замене батарейки. При замене батарейки убедитесь, что уплотнительное кольцо не 
повреждено. В противном случае замените его. Наборы батареек и уплотнительные кольца можно 
приобрести в авторизованных сервисных центрах Polar и продавцов продукции Polar. В США и Канаде наборы 
батареек и уплотнительные кольца можно приобрести только в авторизованных сервисных центрах Polar.  
 

 Держите батарейки в недоступных для детей местах. Если ребенок проглотил батарейку, немедленно 
обратитесь к врачу. Утилизируйте батарейки в соответствии с местными правилами. 

 
* Здесь требуется опциональный датчик s3 Stride Sensor W.I.N.D. 
 

Меры предосторожности 
 
Помехи во время выполнения упражнения 
 
Электромагнитные помехи и оборудование для выполнения упражнения 
 
Помехи могут возникать вблизи  высоковольтных ЛЭП, светофоров, воздушных линий электрифицированных 
ж.д., трамвайных и троллейбусных линий, телевизоров, автомобильных моторов, велокомпьютеров, 
некоторых видов оборудования для выполнения упражнений с электроприводом, сотовых телефонов или при 
прохождении сквозь электроворота безопасности. Во избежание неуправляемых помех держитесь подальше 
от их возможных источников. 
 
Оборудование для выполнения упражнений с электрическими или электронными компонентами, такими как 
СИД-дисплеи, моторы и электротормоза могут быть причиной случайных помех. Для решения подобных 
проблем попробуйте проделать следующее: 
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1. Снимите передатчик с груди и используйте оборудование для выполнения упражнений так, как бы вы это 

делали в обычной обстановке. 
2. Двигайте беговой компьютер, пока на дисплее не исчезнут случайные надписи или не перестанет мигать 

символ сердца. Наиболее уязвимой для помех является пространство перед панелью дисплея, тогда как 
правая и левая стороны дисплея относительно свободны от помех. 

3. Укрепите передатчик обратно на груди и держите беговой компьютер в пространстве, свободном от 
помех, как можно дольше. 

 
Если беговой компьютер по-прежнему «отказывается» работать с оборудованием для выполнения 
упражнений, это может означать, что для беспроводного измерения сердечного ритма все еще слишком 
велик электрофон.  
 
Использование бегового компьютера RS800 в воде 
 
Беговой компьютер является водонепроницаемым, однако измерение сердечного ритма в воде не работает. 
Беговой компьютер можно использовать под водой как часы, но он является прибором для дайвинга. 
Использование бегового компьютера во время ливня может также повлечь за собой возникновение помех. 
 
Минимизация рисков при выполнении упражнений 
 
Упражнения могут включать определенные риски. Прежде чем начать выполнение регулярной программы 
упражнений, рекомендуется ответить на следующие вопросы, касающиеся состояния вашего здоровья. Если 
хотя бы на один вопрос ваш ответ будет «да», перед началом тренировок вам рекомендуется 
проконсультироваться с врачом.  
 
• Были ли вы физически неактивны в последние 5 лет? 
• Есть ли у вас высокое артериальное давление или высокое содержание холестерина? 
• Принимает ли вы лекарства от давления или от сердца? 
• Есть ли у вас симптомы какого-либо заболевания? 
• Находитесь ли в стадии восстановления после серьезного заболевания или лечения? 
• Есть ли у вас электронный стимулятор сердца или иное имплантированное электронное устройство? 
• Вы курите? 
• Вы беременны? 
 
Имейте в виду, что кроме интенсивности упражнений, на сердечный ритм могут влиять сердечные препараты, 
кровяное давление, психологическое состояние, астма, дыхание, а также некоторые энергетические напитки, 
алкоголь и никотин.  
 
Очень важно следить за тем, как ваше тело реагирует на упражнение. Если во время упражнения вы 
чувствуете неожиданную боль или испытываете чрезмерную усталость, рекомендуется либо совсем 
прекратить выполнение упражнения, либо продолжить его в облегченном режиме. 
 
Вниманию лиц с электронным стимулятором сердца, дефибрилляторами или иными 
имплантированными электронными устройствами: использование бегового компьютера - ваш 
собственный риск. Перед началом использования мы обязательно рекомендуем пройти тест на 
максимальный стресс от упражнений под наблюдением врача. В ходе теста определяется безопасность и 
надежность одновременного использования электронного стимулятора сердца и бегового компьютера. 
 
Если вы аллергик или подозреваете возможную аллергическую реакцию на использование прибора, 
проверьте материалы по списку спецификации. Во избежание реакции кожи на передатчик надевайте его 
поверх рубашки, но хорошо смачивайте те ее части, которые находятся под электродами. Это обеспечит 
безупречную работу прибора.  
 
Ваша безопасность очень важна для нас. Форма датчика foot pod/датчика шага* спроектирована так, чтобы 
минимизировать возможность их зацепления чем-либо.  Тем не менее соблюдайте осторожность с датчиком 
foot pod /датчиком шага, когда совершаете пробежки  через заросли кустарника.     
 

 Совместное воздействие влаги и интенсивного абразивного эффекта может стать причиной того, 
что черная краска будет стираться с передатчика и оставлять пятна на светлой одежде. Если вы 
обрабатывает кожу препаратом против насекомых, убедитесь, что кожа при этом не контактирует с 
передатчиком. 

 
* Здесь требуется опциональный датчик s3 Stride Sensor W.I.N.D. 
 

Технические данные 
 
Прибор на запястье 
 
Прибор на запястье относится к лазерным изделиям класса 1.  



Фирменный магазин PolarSport.ru

Polar RS800 Руководство пользователя                 48 
 
 
 
Срок службы батарейки: 
 

Тип батарейки: 
 

Уплотнительное кольцо батарейки: 
 

Рабочая температура: 
 

Ремешок и пряжка: 
 

Задняя часть кожуха: 
 
 
 
 
Точность часов: 
 
Точность монитора сердечного ритма: 
 
 

Амплитуда измерения сердечного ритма: 
 

Диапазон текущей скорости дисплея 
 

Амплитуда текущей скорости дисплея: 
 
 
 
 
 
Допустимый подъём: 
 

Предельные величины датчика на запястье 
 

Макс. число файлов: 
 

Макс. время: 
 

Макс. число кругов: 
 

Обувь 1 - дистанция всего: 
 

Обувь 2 - дистанция всего: 
 

Дистанция – всего: 
 

Общая длительность: 
 

Калории – всего: 
 

Счет упражнений – всего: 
 

Общая длина подъема: 
 

Передатчик 
 

Срок службы батарейки передатчика WearLink 31 
 

Тип батарейки 
 

Уплотнительное кольцо батарейки 
 

Рабочая температура 
 

Материал разъема 
 

Материал ремешка 
 

Датчик шага 
 

Срок службы батарейки  
 

Тип батарейки 
 

Уплотнительное кольцо батарейки 
 

Рабочая температура 
 

Точность 
 

В среднем 1 год (1 ч/день, 7 дней в неделю) 
 

CR2032 
 

Кольцо 20,0 х 1,1 из силикона 
 

От -10 °С до +50 °С   
 

Полиуретан, нерж. сталь 
 

Полиамид, нерж. сталь, соответствующие Директиве 
ЕС 94/27/EU с изменением 1999/с 205/05 об 
удалении никеля с изделий, предназначенных для 
прямого и продолжительного контакта с кожей. 
 
Лучше ± 0,5 сек/день при 25 °С  
 

± 1% или 1 уд./мин. - что больше. Распространяется 
на стабильные условия  
 

15-240 
 

Датчик: 0-36 км/час 
 

- 550 м … + 9000 м. 
Прибор на запястье Polar измеряет амплитуду, 
используя стандартный диапазон амплитуды, 
обусловленным атмосферным давлением в 
соответствии со стандартом ISO 533 
 
5 м. 
 
 
99 
 

99 ч 59 мин 59 сек 
 

99 
 

999 999 км 
 

999 999 км 
 

999 999 км 
 

9999 ч 59 мин 59 сек 
 

999 999 ккал 
 

9999 
 

304 795 м 
 
 
 

В среднем 2 года (1 ч/день, 7 дней в неделю) 
 

CR2025   
 

Кольцо 20,0 х 1,1 из силикона 
 

От -10 °С до +40 °С   
 

Полиамид 
 

Полиуретан/полиамид/полиэстер/ эластан/нейлон 
 
 
В среднем 50 часов использования 
 

Одна размера ААА 
 

Кольцо 25,0 х 1,1 из силикона 
 

От -10 °С до +50 °С   
 

± 3% или лучше в откалиброванном состоянии. 
Распространяется на стабильные условия 
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Polar WebLink, использующая для связи стандарт IrDA, Polar ProTrainer5 
 

Системные требования 
 

 

ПК 
 

Windows® 2000/XP (32 б) 
 

Порт совместимый со стандартом IrDA  
(внешнее IrDA-устройство или ИК порт). 
 

Дополнительно для ПО ваш ПК должен иметь про-
цесссор Pentium II 200 МГц или более быстрый, Мо-
нитор с разрешением SVGA  или выше, простран-
ство для 50-Мб жесткого диска и драйвер CD-ROM. 
 

Беговой компьютер Polar показывает уровень психологического напряжения и интенсивности упражнения. На 
его дисплее изображаются показатели физической формы, а при использовании Датчика S 1 производится 
расчет скорости и длины дистанции. Никакое иное использование бегового компьютера не предполагается и 
не подразумевается. 
 
Беговой компьютер Polar не должен применяться для проведения измерений состояния среды, которые 
потребовали бы профессиональной или производственной точности. Более того, данный прибор не должен 
применяться для получения данных при тренировках на открытом воздухе или под водой. 
 

Водонепроницаемость продукции Polar испытана в соответствии с требованиями международного стандарта 
ISO 2281. По водонепроницаемости продукция разделена на три категории. Категория водонепроницаемости 
вашего прибора изображена на его обратной стороне. Вы можете сопоставить ее с данными приведенной 
ниже таблицы. Просим иметь в виду, что приведенные формулировки не обязательно распространяются на 
продукцию других производителей. 
 

Маркировка на  Водяные Купание и Дайвинг с Дайвинг с Характеристики 
задней стороне  брызги, пот, плавание трубкой (без  дыхательным водонепро- 
крышки   капли дождя   баллонов с аппаратом ницаемости 
   и т.п.    воздухом) для плавания 
         под водой (с 
         баллонами с 
         воздухом) 
Water resistant  X        Брызги, 
(водонепрони-          капли дождя  
цаемый)          и т.п. 
 

Water resistant   X  X      Минимум для ку- 
50 m           пания и плавания 
 
Water resistant   X  X  X    Для частого ис-
100 m           пользования в  
           воде, но не для 
           дайвинга с дыха-
           тельным аппара-
           том для плавания 
           под водой. 
 

* Указанные характеристики распространяются также на передатчики Polar WaterLink 31 и Polar WaterLink 
W.I.N.D., имеющие маркировку Water resistant 30 m. 
 

Часто задаваемые вопросы 
 

Что делать, если… 
 

… на дисплее появляется символ батарейки и надпись battery low? (низкий заряд) 
 

Индикатор низкого заряда батарейки обычно является первым признаком того, что она «села». Однако такой 
индикатор может появляться и при низких температурах. Когда появляется символ, беговой компьютер 
подает звуковой сигнал и подсветка автоматически отключается. Подробнее см. в «Уходе и обслуживании». 
 

… я не знаю, где я в меню? 
 

Нажмите и удерживайте кнопку STOP, пока на дисплее не появится текущее время дня. 
 

… при нажатии на любую кнопку ничего не происходит? 
Верните беговой компьютер в исходное состояние нажатием на все кнопки одновременно и их удерживанием 
в течение 2 секунд, пока дисплей не наполнится цифровыми символами. После этого нажмите любую кнопку 
и установите время и дату в Basic Settings (базовые настройки). Все остальные настройки сохраняются. 
Просмотрите остальные настройки, нажав и удерживая кнопку STOP. 
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… показатель сердечного ритма стал явно ошибочным: сильно завышенным или вообще нулевым 
(00)? 
 
• Убедитесь, что беговой компьютер находится не дальше 1 м от передатчика. 
• Убедитесь, что ремешок передатчика не ослаб во время выполнения упражнения. 
• Убедитесь, что тканевые электроды плотно прилегают к спортивному костюму. 
• Убедитесь, что электроды на передатчике/спортивном костюме увлажнены. 
• Убедитесь в чистоте передатчика/спортивного костюма. 
• Убедитесь, что в радиусе 1 м нет другого передатчика сердечного ритма. 
• Мощные электромагнитные сигналы могут быть причиной явно ошибочного показателя сердечного ритма. 

Подробнее см. в «Мерах предосторожности». 
• Если явно ошибочный показатель сердечного ритма продолжает оставаться, несмотря на удаление от 

источника помех, перейдите на медленный бег и проверьте ваш пульс вручную. Если окажется, что он 
соответствует якобы завышенным показателям на дисплее, значит, вы испытываете сердечную аритмию. 
Большинство случаев аритмии особой угрозы не представляют, тем не менее, проконсультируйтесь с 
врачом.  

• Сердечный приступ мог изменить вашу ЭКГ. В этом случае обратитесь к терапевту.  
 
… на дисплее появилась надпись Memory full? (память переполнена) 
 
Такая надпись появляется, если вы записали уже 99 кругов или для записи упражнения места в памяти не 
осталось. В таком случае прекратите записывать упражнение и перенесите файлы с упражнениями с вашего 
бегового компьютера на Polar ProTrainer5, после чего удалите их с бегового компьютера. 
 
… на дисплее бегового компьютера появилась надпись Check WearLink! (проверьте WearLink) и 
беговой компьютер не может найти сигнал вашего сердечного ритма? 
 
• Убедитесь, что в радиусе 1 м нет другого передатчика сердечного ритма. 
• Убедитесь, что ремешок передатчика не ослаб во время выполнения упражнения. 
• Убедитесь, что тканевые электроды плотно прилегают к спортивному костюму. 
• Убедитесь, что электроды на передатчике/спортивном костюме увлажнены. 
• Если измерения сердечного ритма не происходит со спортивным костюмом, попробуйте это сделать с 

использованием ремешка WearLink. Если с ремешком сердечный ритм определяется, проблема, скорее 
всего, в спортивном костюме. Обратитесь к продавцу/изготовителю костюма. 

• Если вы произвели все вышеуказанные действия, но измерения сердечного ритма все равно не 
происходит, может оказаться, что села батарейка передатчика. Подробнее см. в разделе «Уход и 
обслуживание». 

 
… на дисплее бегового компьютера появилась надпись Check S sensor! (проверьте датчик шага!) и не 
обнаруживаются сигналы скорости и дистанции?* 
 
• Убедитесь, что функция датчика шага отображается на дисплее бегового компьютера. В этом случае на 

дисплее должен быть символ бегуна.  
• Если вы подержите беговой компьютер перед собой более 15 сек, измерение скорости и дистанции 

прекратится. Движением руки деактивируйте измерение. 
• Если вы бежите по бегущей дорожке, а беговой компьютер установлен на перекладине перед вами, 

попробуйте переместить беговой компьютер в сторону. 
• Убедитесь, что датчик шага расположен правильно. 
• Батарейка датчика шага может оказаться разряженной. Подробнее см. в разделе «Уход и 

обслуживание». 
 
… на дисплее бегового компьютера появилась надпись S sensor calibration failed?* (калибровка датчика 
шага сбилась) 
 
Калибровки более нет, ее и необходимо повторить. Калибровка сбивается, если вы при этом двигаетесь. Как 
только вы закончили дистанцию круга, остановитесь и «замрите» для проведения калибровки. Амплитуда 
калибровочного коэффициента во время ручной калибровки составляет 0,500-1 500. Если вы определяете  
калибровочный коэффициент вне этих параметров, калибровка сбивается.  
 
… на дисплее бегового компьютера появилась надпись Teach new sensor? (обучение нового датчика 
шага?) 
 
Если вы приобрели новый датчик шага в качестве принадлежности, его необходимо ввести в беговой 
компьютер. Подробнее см. в разделе «Обучение нового датчика шага». 
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Если в комплект используемого вами оборудования входит датчик шага и на экране появляется 
соответствующий текст, значит, беговой компьютер может улавливать сигнал другого передатчика. В этом 
случае убедитесь, что вы надели именно свой датчик. Если надпись по-прежнему на экране, значит, мал 
заряд батарейки. Подробнее см. в разделе «Уход и обслуживание». 
 

… на дисплее бегового компьютера появилась надпись Too many S sensors nearby? (слишком много 
датчиков шага поблизости) 
 

Во время сеанса обучения зафиксировано более одного сигнала. Беговой компьютер способен воспринимать 
одновременно не более одного сигнала датчика. Беговой компьютер ведет процесс поиска до обнаружения 
первого сигнала. Убедитесь, что в радиусе 20 м от вас нет других датчиков шага. 
 

… я стою на месте, а показатель высоты меняется? 
 

Беговой компьютер переводит замеренное давление воздуха в показатели высоты. По этой же причине 
изменения в погоде могут вызывать изменения показателей высоты. 
 

… показатели высоты неточны? 
 

Ваш альтиметр может показывать неправильные данные, если подвергается воздействию внешних помех, 
таких как сильный ветер или поток воздуха из кондиционера. В таком случае попробуйте откалибровать 
альтиметр. Если его показатели постоянно неверны, может оказаться, что каналы приема воздушного 
давления забиты грязью. В этом случае беговой компьютер следует отправить в сервисный центр Polar.    
 

… на дисплее бегового компьютера появилась надпись Memory low? (маленький запас памяти) 
Такая надпись появляется, когда остается место примерно для 1 часа записи. Для максимизации оставшегося 
массива памяти установите самую медленную скорость записи (60-сек), выбрав Settings> Features> Rec. 
rate. При резком истощении массива памяти на дисплее появляется Memory full. Для освобождения памяти 
перенесите упражнения в программное обеспечение Polar Pro Trainer5 и удалите их из памяти бегового 
компьютера.  
 

* Здесь требуется опциональный датчик s3 Stride Sensor W.I.N.D. 
 

МЕЖДУНАРОДНАЯ ГАРАНТИЯ КОМПАНИИ Polar ОГРАНИЧЕННОГО ДЕЙСТВИЯ 
 
• Гарантийные обязательства компании Polar Electro Inc. (Производителя) определены положениями 

ограниченной международной гарантии, действие 
которой распространяется на пользователей, которые приобрели настоящий продукт на территории США 
и Канады. 
Гарантийные обязательства компании Polar Electro Oy (Производителя) определены положениями 
ограниченной международной гарантии, действие которой 
распространяется на пользователей, которые приобрели настоящий продукт в любых других странах, 
отличных от США и Канады. 

• Компания Polar Electro Inc./Polar Electro Oy гарантирует покупателю настоящего продукта, что монитор 
сердечного ритма (Изделие) не имеет дефектов 
материалов и свободен от производственных дефектов. Настоящее гарантийное положение действует в 
течение 2 лет с даты покупки Изделия. 

• Покупателю рекомендуется сохранять Международную гарантийную карточку на Изделие или 
квитанцию торгового предприятия, в котором 
было приобретено Изделие (кассовый чек), так как данные виды документов служат 
подтверждением факта покупки. 

• Настоящая Гарантия не распространяется на элементы питания, повреждения, возникшие вследствие 
неправильного обращения или ненадлежащего 
применения, случайного повреждения, несоблюдения мер предосторожности. Настоящая Гарантия не 
распространяется на повреждения, вызванные 
неправильным обслуживанием, или возникшие вследствие коммерческого использования. Не 
распространяется на повреждения корпуса и ремешка. 

 

• Гарантийное покрытие по настоящим положениям не распространяется на любой ущерб, повреждения, 
издержки или убытки, прямые, косвенные или 
побочные, сопутствующие или специфические, связанные с использованием Изделия, или вытекающие 
из такого использования. В течение действия 
Гарантийного срока настоящее Изделие будет либо отремонтировано, либо заменено в авторизованном 
сервисном центре; ремонт и замена по Гарантии 
осуществляются бесплатно. 

• Настоящая Гарантия не затрагивает и не ущемляет установленные законом права потребителя, в рамках 
применимого действующего национального 
законодательства, или права потребителя по отношению к дилеру, вытекающие из договора купли-
продажи, заключенного с таким дилером. 
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СЕ 0537 
Данное изделие соответствует Директивам 93/42/ЕС и 1999/5/ЕС. Соответствующая Декларация 
соответствия доступна на сайте www.support.polar.fi/declaration_of_conformity.html  

Данный символ перечеркнутого мусорного бака на колесах означает, что продукция Polar относится к 
электронным устройствам, входящим в поле действия Директивы 2002/96/ЕС Европарламента и Совета по 
утилизации электронного и электрического оборудования (WEEE). Соответственно, в странах ЕС указанные 
изделия должны утилизироваться отдельно. Компания Polar также будет приветствовать соблюдение норм 
охраны окружающей среды и здоровья людей в странах вне ЕС путем соблюдения местных норм и 
раздельной утилизации электронного и электрического оборудования. 
Авторское право © 2006 принадлежит компании  Polar Electro Oy, Финляндия, Кемпеле, FIN-90440. 
Компания  Polar Electro Oy сертифицирована по стандарту ISO 9001:2000. 

Все правы сохраняются. Ни одна из частей настоящей инструкции не может быть использована или 
воспроизведена без предварительного письменного разрешения компании  Polar Electro Oy. Названия и 
логотипы, отмеченные в данной инструкции или пакете документов, придаваемых к товару, значком ™, 
являются торговыми марками компании  Polar Electro Oy.  Названия и логотипы, отмеченные в данной 
инструкции или пакете документов, придаваемых к товару, значком ™, являются зарегистрированными 
торговыми марками компании  Polar Electro Oy. Названия и логотипы, отмеченные в данной инструкции или 
пакете документов, придаваемых к товару, значком ®, являются зарегистрированными торговыми марками 
компании  Polar Electro Oy, кроме Windows, являющимся зарегистрированной торговой маркой компании 
Microsoft..  

ЗАЯВЛЕНИЕ КОМПАНИИ Polar 
• Материалы, изложенные в настоящем Руководстве Пользователя, предназначены только для

информационных целей. Описанные в настоящем документе 
модели монитора сердечного ритма (ЧСС) могут быть модифицированы без предварительного 
уведомления, в соответствии с программой технического 
развития и модернизации, разрабатываемой производителем. 

• Компания Polar Electro Inc./ Polar Electro Oy не делает никаких представлений и не дает никаких
гарантий и поручительств, применительно к тексту 
настоящего Руководства, равно как в отношении любых продуктов и изделий, описание которых 
приводится в тексте данного Руководства.  
Компания Polar 

• Electro Inc./Polar Electro Oy не несет никаких обязательств и не принимает на себя никакой
ответственности в отношении любого ущерба, повреждения, 
издержек или убытков, прямых, косвенных или побочных, сопутствующих или специфических, связанных 
с использованием Изделия, или вытекающих из 
такого использования Изделия или Изделий, описание которых приведено в настоящем Руководстве 
Пользователя. 

Изделие, описание которого приведено в контексте настоящего Руководства, защищено одним или 
несколькими из перечисленных ниже патентов: WO 96/20640, US 6104947, US 6277080, WO 97/33512, GB 
2326240, HK 1016857, US 6361502, US 6418394, US 6537227, US 5719825, US 5848027, EP 1055158, FI 68734, 
DE 3439238, GB 2149514, HK 812/1989, US 4625733, FI 88972, FR 92.09150, GB 2258587, HK 306/1996, SG 
9592117-7, US 5486818, FI 96380, US 5611346, EP 665947, DE 69414362, FI 110915. 
Заявки на остальные патенты поданы. 

ОПТОВЫЕ ПРОДАЖИ 
тел: (495) 937-39-95 
www.polar-russia.ru 

 
Сервис-центр POLAR в Москве: 

тел:(495) 956-50-00 

 компания PolarSport
 www.PolarSport.ru
 
 +7(495) 22-33-586
 mail@polarsport.ru

мониторов сердечного ритма Polar в России и странах СНГ 

Фирменный магазин Polar: 
 

Замена батереек и ремешков:
Гончарный проезд дом 8/40

+7(495)22-33-586

По России :+7(800) 333-47-06

г.Москва Гончарный проезд д.8/40

Официальный дилер

www.polarsport.ru

Москва:
 Нахимовский пр.т 56 
Тел:8(495)956-50-00

Санкт-Петербург:
наб.Карповки 6
Тел:8(812)346-13-38

www.polarsport.ruwww.PolarSport.ru
компания PolarSport
www.polarsport.ru
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